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C H A P T E R 1

QuickStart: Creating A GroupSpace 
Community

GroupSpace is a Community template that lets you quickly create a project management-type 
Community. This chapter will help you create and start using a GroupSpace Community. The 
remaining chapters in this guide explain how to work with a GroupSpace Community.

WebLogic Portal ships with an Example GroupSpace Community. From the Windows Start 
Menu, start the server by choosing BEA Products > Examples > WebLogic Portal > Start 
GroupSpace Example Server. Launch the GroupSpace Example Community by choosing BEA 
Products > Examples > WebLogic Portal > Visit GroupSpace. You can also access the 
GroupSpace Example Community at 
http://localhost:7041/groupspace/groupspace.jsp.

This chapter contains the following topics:

Creating a Portal Domain and Application

Creating a GroupSpace Community Template

Creating a GroupSpace Community

Creating a Portal Domain and Application
Before you create a GroupSpace Community, follow the instructions in the Getting Started with 
WebLogic Portal tutorial to create a WebLogic Portal domain and application (portal EAR 
project, portal web project, and datasync project) that are GroupSpace enabled.

../tutorials/index.html
../tutorials/index.html
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Note: When creating the domain and applications, select all the GroupSpace facet check boxes 
and the WebLogic Portal Collaboration Repository check box. You must select them to 
be able to create a GroupSpace Community.

Creating a GroupSpace Community Template
Before you create a GroupSpace Community, you must create a GroupSpace community 
template. A Community template is a packaged set of resources you can use to build a project 
management or collaboration application. You can use the GroupSpace Community template you 
create to make a new GroupSpace Community without writing additional code.

Perform the following steps to create a community template:

1. Make sure the server is running for your WebLogic Portal domain. In WorkSpace Studio, 
open the WebLogic Portal Administration Console by selecting your portal EAR project in 
the Navigator view and choosing Run > Open Portal Administration Console.

2. Log into the Administration Console with the username and password you defined for the 
domain.

3. In the Administration Console, choose Portal > Portal Management. 

4. In the Resource tree, select Portals and create a portal if necessary.

5. Expand the folders for the portal you created, expand the Templates folder, and select 
Community Templates.

6. In the Community Templates section, click Create Community Template as shown in 
Figure 1-1.
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Figure 1-1  Create a New GroupSpace Community Template

7. In the Create Community Template: Step 1 window, pick one of the following options:

– From a community template metadata file –Quickly set all the properties for your 
template by selecting a Community template metadata file in the current web 
application. This is the recommended method and is the most common method to 
create a Community template. The .ctmeta file defines the GroupSpace Community 
settings. 

– Select resources in the Library – Do not select this option for a GroupSpace 
Community; select this for a non-GroupSpace Community.

– Select a .portal file – Do not select this option for a GroupSpace Community; select 
this for a non-GroupSpace Community.

After you select an option, click Next. The first option, From a community template 
metadata file, is shown in Figure 1-2 through Figure 1-6.
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Figure 1-2  Select the Method to Use to Create a Community Template

8. In the Create Community Template: Step 2 window, you chose From a community template 
metadata file in the previous page, so click Show All and select the pre-configured 
groupspace.ctmeta database file. Figure 1-3 shows the next step after selecting From a 
community metadata file selection. Select groupspace.ctmeta and click Next.
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Figure 1-3  Selecting the Pre-Configured groupspace.ctmeta File

9. In the Create Community Template: Step 3 window, enter the following information:

– Community Template Title – Enter the name of the GroupSpace Community. For 
example, GroupSpace Template. This field is required.

– Description – Enter text describing the Community template.

– Default Shell – You must select Community Header-Footer Shell from the 
drop-down menu. 

– Look And Feel – Select a Look And Feel for this Community from the drop-down 
menu.

– Add this template to the Library – Select this check box to add this template to the 
Community template library. You can use the template to create communities in other 
GroupSpace portals in the current portal web project. See Figure 1-4.
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Figure 1-4  Enter a Name for the Community Template

10.  In the Create Community Template: Step 4 window, review the following fields that are 
pre-populated by the template. Each template can have different defaults. After you enter the 
following information, click Review Properties or click Create Template:

– Allow non-members to access the community – This check box is disabled, because 
non-members cannot join a GroupSpace Community. 

– Allow anyone to register for community membership – Select this check box to 
allow public registration and not require an invitation to join a Community.

– Allow people to customize their view and add personal pages – Select this check 
box to add personal pages and data. If you choose to not select this check box, 
Community members cannot customize the GroupSpace Community to add pages and 
books to the Community. 

– Track member visits to the community – If you are using the default Community, 
you cannot select this check box to monitor how many times a member logs into the 
GroupSpace Community.

– Registration page – Review the name of the URI that displays for users to register. For 
example, /portlets/access/registration.portal.
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– Error page – Review the name of the URI that displays for the error page. For 
example, /groupspace.jsp.

– Callback Class for Community Delete – Review the callback class (for example, 
com.bea.apps.groupspace.security.GroupSpace). When a Community is 
deleted, for example, you might want to use a callback class to archive its content and 
send a note to the former members of that Community to advise them that the 
Community no longer exists.

– Expiration Date – Set the date and time zone when the Community expires. The 
default is to never expire.

If another template exists, you are prompted to resolve the conflict.

 Other Community information is also copied from the template, such as the portal path, 
access tracking status, and other generic properties. See Figure 1-5.

Figure 1-5  Enter a Name for the Community Template

11. If you clicked Review Properties in step 10, click Create Template.

12. In the Create Community Template: Step 6 window, click Finish, as shown in Figure 1-6.
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Figure 1-6  Click Finish to Create the New Community Template

Creating a GroupSpace Community
After you create a GroupSpace Community template, you can create your GroupSpace 
Community.

Perform the following steps to create a GroupSpace Community:

1. In the Administration Console, choose Portal > Portal Management.

2. In the Resource Tree, select Portal and expand the folder that contains the new portal you 
created in “Creating a GroupSpace Community Template” on page 1-2.

3. Select the Communities folder and click Create Community in the Community Contents 
section.

4. In the Create Community Instance: Step 1 window, select Use a Community Template to 
choose a template that defines the Community's shell, Look and Feel, and contents. The 
recommended method for creating a GroupSpace Community is to choose the GroupSpace 
Community template you created in “Creating a GroupSpace Community Template” on 
page 1-2. If you did not create or do not need a Community Template, you can also choose 
Select a .community or .portal file to select the groupspace.community file directly. Some 
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Communities, such as GroupSpace, require additional information located in a Community 
template metadata file (for example, groupspace.ctmeta file). Do not choose Select 
resources in the Library because this required GroupSpace Community metadata will not 
be applied and the GroupSpace Community will not work. See the Portal Guide for more 
information on library resources and .portal files.

Click Next.

5. In the Create Community Instance: Step 2 window, click Show All and select a template, 
resource, or .portal file. Select the item and click Next.

6. In the Create Community Instance: Step 3 window, enter the following details:

– Title – Enter the name of the new Community. For example, Project Management 
GroupSpace.

– Description – Enter text describing the Community.

– Partial URL – Enter a short URL for the new Community. For example, project.

– Allow non-members to access this community – Do not select this check box, since 
non-members cannot join a GroupSpace Community.

– Allow anyone to register for community membership – Select this check box to 
allow public registration and not require an invitation to join a Community.

– Allow people to customize their view and add personal pages – Select this check 
box to let users customize their personal pages and persist those changes.

– Registration URI – Review the name of the URI that displays for users to register. For 
example, /portlets/access/registration.portal.

– Error URI – Review the name of the URI that displays for the error page. For 
example, /portlets/access/err.jsp.

Click Create Community, as shown in Figure 1-7 or click Review Properties.

../portals/index.html
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Figure 1-7  You Can Edit Community Properties

7. If you clicked Review Properties in step 6, you can change the Expiration Date for the 
Community if you want in the Create Community Instance: Step 4 window. Verify that the 
Make this community active now check box is selected. If you deselect the Make this 
community active now check box, you cannot access the Community. Click Create 
Community.

8. In the Create Community Instance: Step 5 window, click Finish. You can also click Go to 
Community to go directly to the GroupSpace Community. An Invitation to join the new 
GroupSpace Community was created. You must log into your new GroupSpace application to 
accept the Invitation. Your role is owner/creator, so that you can then invite other users to join 
and you can perform other administrative tasks.

9. Log into your new sample GroupSpace Community and accept your invitation. Perform the 
following steps:

a. Access the URL for the new Community you created.

b. Enter the username and password of weblogic/weblogic and click Login.

c. In the GroupSpace Invitations section, click the Community name that you created.
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d. In the Community Registration page, enter the username and password of 
weblogic/weblogic and click Login.

e. In the GroupSpace Home page, click the Community name.

After you accept your invitation to join the GroupSpace Community, you can invite others to join 
the Community and entitle users to control what they can do. See Chapter 6, “Managing 
GroupSpace” for more information on managing your new GroupSpace Community.

Note: All types of users (including a user with view-only rights in a GroupSpace Community) 
can create a Community. To restrict a view-only user from creating a new Community, 
follow these steps to define a visitor entitlement policy:

Create a visitor entitlement role using the Administration Console.

Add the users who need to have the right to create Communities to the visitor 
entitlement role.

Add the entitlement role to the portal you want, and enable the Create Community 
capability. The Create Community capability is available only for the portal 
resource type.

This visitor entitlement policy disables the Create Community option in the GroupSpace 
Community for users who do not belong to the visitor entitlement role. For more 
information on Visitor Entitlements, see Restricting Portal Visitor Access USing 
Entitlements in the the Security Guide. 

After your users join the GroupSpace Community, they can use the portlets to collaborate with 
others and share information. See Chapter 7, “Using the GroupSpace Portlets”.

../security/planning.html#wp1021317
../security/planning.html#wp1021317
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C H A P T E R 2

Introduction

WebLogic Portal provides the ability to create a GroupSpace Community, a collaboration tool for 
groups of users who need to work together and share information. GroupSpace is built on the 
Communities Framework, and provides a dedicated, secure, self-managed environment to share 
information. The Communities Framework is built on the WebLogic Portal Framework, and 
leverages WebLogic portal features, such as a dynamic and extensible rendering framework, 
security, federation, content management, search, personalization, and end-user customization.

A GroupSpace Community is an instance of a Community that is built using the GroupSpace 
Community template. A Community is an extension of a portal desktop that contains group 
membership, member roles and capabilities, invitations, and look and feel customization. The 
Community template includes pages, books, portlets, layout, look and feel tools, invitations, and 
membership roles and capabilities. You invite users to join the Community and assign a role and 
capabilities to control what they can see and do in the Community.

When you run the WebLogic platform installer, it creates a domain in the 
\<WEBLOGIC_HOME>\samples\domains\portal directory and creates a sample GroupSpace 
application called GS Example Community, which is targeted to the domain. (You can also use 
the Configuration Wizard at \<WEBLOGIC_HOME>\common\bin\config.cmd or config.sh to 
create a different domain.) View the GS Example Community at 
http://localhost:7041/groupspace/_groupspace.jsp. Insert your machine name for 
<localhost>. 

A GroupSpace Community includes the following portlets to support a collaborative work 
environment:

Mail
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Calendar

Contacts

Tasks

GS Announcements

GS Issues

GS GroupNotes

GS Links

GS RSS Reader

Discussion Forums

GS Document Library

CM Browser

GS Enterprise Search

GS Search

This chapter contains the following topics:

GroupSpace Communities in the Portal Life Cycle

Getting Started

GroupSpace Communities in the Portal Life Cycle
This section contains the following topics:

Architecture

Development

Staging

Production

The tasks in this guide are organized according to the portal life cycle. The portal life cycle 
contains four phases: Architecture, Development, Staging, and Production. Adding a 
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GroupSpace Community to your portal is an important part of the portal life cycle. For more 
information about the portal life cycle, see the WebLogic Portal Overview.

Figure 2-1 shows which Interaction Management tasks occur in each phase.

Figure 2-1  GroupSpace Community Tasks in the Four Phases of the Portal Life Cycle

Architecture 
In the Architecture phase, you enable GroupSpace in your portal domain, portal EAR project, and 
portal web project. For more information about the portal life cycle, see the WebLogic Portal 
Overview.

The following chapter provides guidance on Architecture tasks:

Chapter 3, “Planning Your GroupSpace Community” describes how to structure your 
GroupSpace Community, the GroupSpace components that are installed, and the benefits 
of using a GroupSpace Community.

4. Production – Cre-
ate your 
GroupSpace Com-
munity in a Produc-
tion environment, 
invite others to join, 
and make other 
changes as needed

3. Staging – Use the 
Administration Con-
sole to create Com-
munity templates

2. Development – 
Create a domain, a 
portal EAR project, 
a web application, 
and a GroupSpace- 
enabled portal in 
WorkSpace Studio, 
and add the 
GroupSpace con-
tent repository

1. Architecture – Deter-
mine what type of Com-
munity and features you 
want to add to your portal

../overview/index.html
../overview/index.html
../overview/index.html


In t roduct ion

2-4 BEA WebLogic Portal GroupSpace Guide

Development
In the Development phase, you enable e-mail-based invitations (you can do this in the 
GroupSpace Community itself or by editing the communities-config.xml file), and manually 
add the GroupSpace CM repository.

Tools: WorkSpace Studio.

The following chapter provides instructions on Development tasks:

Chapter 4, “Working with GroupSpace in Development” provides direction on creating a 
GroupSpace-enabled portal, enabling e-mail-based invitations, and adding the GroupSpace 
CM repository.

Staging
In the Staging phase, portal administrators use the WebLogic Portal Administration Console to 
create a GroupSpace Community template.

If any of the functionality needs to change, developers can return to the Development phase and 
make changes using WorkSpace Studio. Developers must redeploy the portal application to see 
the changes in the Staging environment. The Development phase and the Staging phase often 
occur simultaneously.

Tools: WebLogic Portal Administration Console.

The following chapter provides instructions on Staging tasks:

Chapter 5, “Creating a GroupSpace Community Template” shows how to create a 
GroupSpace Community template and a GroupSpace Community.

Production
After developers test the portal application in the Staging phase, portal administrators use the 
Production phase to fine-tune the live production environment.

In the Production environment you create the GroupSpace Communities.

If you need to change any of these features, developers can use WorkSpace Studio to return to the 
Development phase and make changes. Developers must redeploy the portal application to see 
the changes in the Staging environment.

Tools: WebLogic Portal Administration Console.

See Part IV: Production for guidance on Production tasks.
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Getting Started
If you are new to portal development, see the Overview for more information about the portal life 
cycle. You can consult the Communities Guide for more information about developing a custom 
Community.

You can also check the GroupSpace blog located on Dev2Dev at: 
http://dev2dev.bea.com/pub/au/192.

http://dev2dev.bea.com/pub/au/192
../overview/index.html
../communities/index.html
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Part I Architecture

Part I includes the following chapter:

Chapter 3, “Planning Your GroupSpace Community”

This section contains guidelines to help you plan your strategy for creating a GroupSpace 
Community. When you are planning how your users will interact with your GroupSpace 
Community, consider the following:

How many users will access the GroupSpace Community

How users will register

What type of personalized content users will see

Which portlets users will access in the GroupSpace Community

Part I contains instructions for planning your GroupSpace Community in the Architecture phase. 
When you finish the Architecture phase, you can proceed to the Development phase, and then on 
to the other phases.

For a description of the Architecture phase of the portal life cycle, see the WebLogic Portal 
Overview The portal life cycle is shown in the following graphic:

../overview/index.html
../overview/index.html
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C H A P T E R 3

Planning Your GroupSpace Community

This chapter describes components in the GroupSpace application and shows you how to enable 
GroupSpace in your domain, portal EAR projects, and portal web projects.

The chapter contains the following topics:

Understanding GroupSpace Components

Adding GroupSpace to your Applications

Understanding GroupSpace Components
When you create a GroupSpace Community, the following GroupSpace-specific components are 
installed:

GroupSpace Library Module – The wlp-groupspace-app-lib library module and the 
wlp-groupspace-web-lib library module.

Community and GroupSpace Template – Defined by the .ctmeta file, the .community 
file, and the communities-config.xml file.

GroupSpace Controls – See the Communities Guide for more information.

Portlets – Contains the following two types of portlets: 

– GroupSpace-specific portlets – Portlets that begin with GS, such as GS GroupNotes. 
These portlets cannot be used outside of a GroupSpace Community.

../communities/index.html
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– Collaboration portlets – Portlets that do not begin with GS, such as Discussion Forums. 
These portlets can be used outside of a GroupSpace Community. See the Portlet 
Development Guide for more information.

GroupSpace Invitations

GroupSpace Notifications

Adding GroupSpace to your Applications
This section shows you how to enable GroupSpace in your applications; you must ensure 
GroupSpace is included in your portal domain, and add the GroupSpace libraries and facets to 
your portal EAR and web projects.

Tip: You should have only one GroupSpace web project per enterprise application. If you 
create a conventional portal web project to present your desktops and portlets, do not 
enable GroupSpace for that project.

 If you want to create custom Communities, you must create a separate portal web project that 
does not include GroupSpace, as illustrated in Figure 3-1. 

../portlets/index.html
../portlets/index.html
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Figure 3-1  GroupSpace Must Reside in its Own Portal Web Project

Adding GroupSpace to Your Portal Domain
1. If you have an existing server and it is running, stop the server.

2. Start the Configuration Wizard. From the Windows Start menu, choose BEA Products > 
Tools > Configuration Wizard.

3. In the Configuration Wizard, select Create for a new domain or Extend for an existing 
domain, and click Next. 

4. If you selected Create in step 3, select WebLogic Portal Collaboration Repository check 
box and click Next. Select the WebLogic Portal GroupSpace Application check box only 
if you want to add an out-of-the-box GroupSpace application. If you are extending an existing 
domain, select the domain root directory, and click Next.

5. Complete the remaining wizard windows.

6. Restart the server.

Adding GroupSpace to Your Portal EAR and Web Project
Perform the following steps to add GroupSpace to your portal EAR and web project:

Portal EAR Project

 Portal Web
Project
(portals with 
desktops)

PorPortal Domain

Portal Web
Project
(GroupSpace 
enabled)
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1. Add the GroupSpace facets to your portal EAR project:

a. In the Navigator view in WorkSpace Studio, right-click an existing portal EAR project and 
choose Properties. If you are creating a new portal EAR project, skip to step c in this 
section when you reach the Select Project Facets window.

b. In the Properties window, select Project Facets, and click Add/Remove Project Facets.

c. In the Project Facets window, expand WebLogic Portal Collaboration and select 
GroupSpace Application Libraries. If you are creating a new portal EAR project, 
continue through the remaining wizard windows.

d. Click Finish, and then click OK.

2. Add the Collaboration Portlets facet to your portal web project. Perform the same steps 
above to the web project, and select the GroupSpace facet.
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Part II Development

Part II includes the following chapter:

Chapter 4, “Working with GroupSpace in Development”

Developers use WorkSpace Studio in the Development phase to create a portal that is 
GroupSpace-enabled. After you create the portal, you enable e-mail-based invitations and 
configure the database (if you created a new domain). You can also create a custom GroupSpace 
Community or .ctmeta files during the Development phase.

For a detailed description of the Development phase of the portal life cycle, see the WebLogic 
Portal Overview. The portal life cycle is shown in the following graphic:

../overview/index.html
../overview/index.html
../overview/index.html
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Working with GroupSpace in 
Development

Working with a GroupSpace Community in the development phase involves enabling 
e-mail-based invitations and performing other optional development tasks to extend a 
GroupSpace Community.

The chapter contains the following topics:

Creating a GroupSpace Community

Extending the Default GroupSpace

Community Properties Reference

Analyzing GroupSpace Events

Changing the GroupSpace Look & Feel

Setting Up the Rich Text Editor

Searching for Microsoft Word, Excel, and PowerPoint Files in Multibyte Languages

Creating a GroupSpace Community
Creating a GroupSpace Community is ultimately performed by a portal administrator in the 
Administration Console, or by a GroupSpace end user with appropriate rights. GroupSpace 
Communities, like all Communities, are rendered from the database (rather than the file system). 
In order to create a GroupSpace Community, those administrators and users rely on resources that 
are accessible from the development environment.
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Development tasks are not required for administrators and end users to create default GroupSpace 
Communities. There are primary resources involved in the creation of GroupSpace 
Communities—resources that developers can extend or modify as needed.

Before you decide to use GroupSpace, see Planning and Designing Communities in the 
Communities Guide to help you determine your Community needs.

Understanding GroupSpace Resources
The GroupSpace shared J2EE libraries contain the following resources. To see these resources, 
open the Merged Projects view.

Shell – A Community shell containing the Visitor and Community Tools. GroupSpace uses 
this shell and applies look and feel overrides to give the header its appearance. Location: 
<portalWebProject>/communityFiles/.

Look and Feel – A default GroupSpace Look and Feel. Location: 
<portalWebProject>/framework/skins/ or 
<portalWebProject>/framework/skins/gsdefault/.

Invitation – The invitation e-mail that is sent to Community invitees. Location: 
<portalWebProject>/invitations/.

Portlets– The GroupSpace and Collaboration Portlets. Location: 
<portalWebProject>/portlets/.

The groupspace.community file – A portal file with a .community extension. Portal 
administrators use this file to create a GroupSpace Community. Location: 
<portalWebProject>/<WebContent>/groupspace.community.

The groupspace.ctmeta file – A Community template metadata file that provides 
preconfigured settings for the default GroupSpace Community. This file is used to create a 
a Community template and a Community, and references the .community file to use to 
create the Community. The file also contains advanced settings that make Community 
template creation easy for portal administrators. Location: 
<portalWebProject>/<WebContent>/groupspace.ctmeta.

The communities-config.xml file – This enterprise application-level file lets you 
configure the e-mail settings for your e-mail server (to send Community invitations) and 
lets you add security capabilities to your Communities.

Note: The Page Flow source files used throughout GroupSpace are not available for override.

../communities/architecture_plandesign.html
../communities/index.html
../communities/index.html
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You can use these resources without modification in order to create default GroupSpace 
Communities, or you can develop customizations to configure your own version of GroupSpace. 
For information on customizations you can make, see Extending the Default GroupSpace.

Enabling E-Mail-Based Invitations
After you create your portal application, you can use one of the following methods to enable 
e-mail-based invitations:

1. Launch your GroupSpace Community and use the following steps in the UI to configure 
e-mail invitations:

a. Log into your GroupSpace Community.

b. Choose Communities > Manage This Community.

c. On the Properties Page tab, click Community Email Configuration.

d. In the Reply-to Address field, enter your e-mail address.

e. In the Display Name, enter the name you want to appear in the From field in your e-mails.

f. In the Outgoing Mail Server (SMTP) field, enter the outgoing host name or IP address.

g. In the Outgoing Mail Port (SMTP) field, enter the port number to connect to the 
outgoing mail server. For example, enter 25 for SMTP.

h. In the Account username (SMTP) field, enter the name of your mail account. Do not use 
special characters.

i. In the Account passsword (SMTP) field, enter a password.

j. Click Save.

2. You can also manually configure e-mail invitations by locating the 
communities-config.xml file in the \META-INF directory of your EAR application and 
editing it. For example, C:\Documents and 
Settings\dsmith\workshop\myportalEAR\META-INF. If you do not have a 
communities-config.xml file, you must create one by copying Listing 4-1 to a text file.

a. Open the communities-config.xml file in a text editor and customize the information 
in the following lines, as shown in Listing 4-1.
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Listing 4-1   Enter Your Values in the communities-config.xml File

<?xml version="1.0" encoding="UTF-8"?>

<communities-config xmlns="http://www.bea.com/ns/portal/ 

90/communities-config">

     <properties-config>

          <property-map>

               <name>groupspace.DefaultEmailConfiguration</name>

               <property>

                    <name>replyToAddress</name>

                    <value>--Please Change-- some.user@

                         yourcompany.com</value>

               </property>

               <property>

                    <name>displayName</name>

                    <value>GroupSpace Emailer</value>

               </property>

               <property>

                    <name>smtpServer</name>

                    <value>--Please Change-- smtp.yourdomain.com</value>

               </property>

               <property>

                    <name>smtpPort</name>

                    <value>25</value>

               </property>

               <property>

                    <name>smtpUsername</name>

                    <value>--Please Change-- smtpuserid</value>

               </property>

               <property>

                    <name>smtpPassword</name>

                    <value>--Please Change-- smtppassword</value>

               </property>

          </property-map>

     </properties-config>

</communities-config>
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b. Save the communities-config.xml file. You can change these settings later in your 
GroupSpace Community by choosing Communities > Manage This Community and 
selecting the Properties Page tab. You can change these settings for each GroupSpace 
instance.

Note: If you plan to run the sample GroupSpace application, the database is already 
configured. By default, all domains are configured to use PointBase.

Configuring the Database in a New Domain
WebLogic Portal 9.2 domains used the WebLogic Portal GroupSpace Framework Application 
template to create a GroupSpace database, while Portal 10.0 domains use the WebLogic Portal 
GroupSpace Application Collaboration Repository. See “Adding GroupSpace to Your Portal 
Domain” on page 3-3 for more information.

If you created a new domain or extended an existing domain with the Configuration Wizard, you 
can use a database other than PointBase. PointBase is the default database. The items you create 
in the GS Example Community are stored in the GroupSpace database. The CM Browser portlet 
displays read-only content from the Shared Content Repository.

1. Perform the following steps to add GroupSpace content repository database objects, and then 
add and configure an appsGroupSpaceDataSource to point to the non-PointBase 
GroupSpace database you define:

a. If the WebLogic Server and the WebLogic Portal Administration Console are running, 
stop them.

b. Back up your database data as described by your database vendor.

c. For new 10.0 domains, the WEBLOGIC_GROUPSPACE schema is automatically 
created within the default PointBase database. The appsGroupSpaceDataSource is 
automatically added to the new domain and configured to access the 
WEBLOGIC_GROUPSPACE schema. GroupSpace database objects must reside in a 
different database schema than the main portal database objects (which were created in 
the WEBLOGIC PointBase schema by default).

For a PointBase database, go to step d. For the following types of databases, a Database 
Administrator must define a database user or database for the WebLogic GroupSpace 
database schema:

• For Oracle, see <WLP_HOME>/db/oracle/admin/create_tablespaces.sql and 
create_users.sql.
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• For SQL Server, see 
<WLP_HOME>/db/sql_server/admin/create_database.sql.

• For mySQL Server, see <WLP_HOME>/db/mysql/admin/create_database.sql

• For Sybase, see <WLP_HOME>/db/sybase/admin/create_devices and 
create_database.sql.

• For DB2, see <WLP_HOME>/db/db2/admin/create_tablespaces.sql and 
create_user.sql.

For more details on running these scripts, see the Database Administration Guide

d. Edit the domain's groupspace_database.properties file to set the database and user 
information for the GroupSpace Content Management Repository database. 

e. You can use the BEA WebLogic Configuration Wizard (see the BEA Products Creating 
WebLogic Domains Using the Configuration Wizard Guide for detailed instructions) or 
run create_db.cmd -database.properties=groupspace_database.properties 
from the domain's home directory (or . ./create_db.sh 
-database.properties=groupspace_database.properties) to add the 
GroupSpace database objects.

f. After you define a non-PointBase database in a new 9.x domain, you can replace the 
appsGroupSpaceDataSource (which points to PointBase by default) in your domain 
with the one from the appropriate driver directory, and then update it for your database 
environment. Manually edit the @CMREPO_DB...@ variables for the database you 
configured in step c. Sample appsGroupSpaceDataSource-jdbc.xml definition files 
for each database and driver that BEA supports are available in the following general 
locations: <WLP_HOME>/db/jdbc/<database_driver>. For example, oracle_bea or 
sybase_bea.

For more details on setting up your GroupSpace database, see the Database Administration 
Guide.

2. Start the server by changing to the /<WEBLOGIC_HOME>/samples/domains/portal/bin/ 
directory and typing startWebLogic.cmd. You can view the GS Example Community, 
which is populated with sample data, at http://<localhost>:7041/groupspace/ 
groupspace.jsp. The CM Browser portlet uses the Shared Content Repository; all other 
data is stored in the Community Repository.

../../../common/docs100/confgwiz/index.html
../../../common/docs100/confgwiz/index.html
../db/index.html
../db/index.html
../db/index.html
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Tip: To stop the server, change to the  
/<WEBLOGIC_HOME>/samples/domains/portal/bin/ directory and type 
stopWebLogic.cmd.

After you create a portal, the next step is to create a Community template. A Community template 
is a packaged set of resources that you can use to build a project management or collaboration 
application. You can create a Community template and use that template to create a new 
Community without writing additional code. See Chapter 5, “Creating a GroupSpace Community 
Template” for instructions on creating a GroupSpace Community template.

After you create a GroupSpace template in the Staging phase, you can propagate that template to 
the production environment where it can be used to create GroupSpace Communities.

Extending the Default GroupSpace
The default GroupSpace template and resources let you quickly and easily create a full-featured 
GroupSpace Community. However, there might be times when you want to modify the default 
GroupSpace template. For example:

You could create a new .community file that provides a different configuration of 
GroupSpace portlets.

If you did not want to use the Mail portlet, you could remove it from the 
groupspace.community file.

You could modify the default e-mail message that is sent to GroupSpace invitees, or you 
may want to hard-code a date that GroupSpace Communities expire.

You could add new security capabilities to your Communities that work with security 
restrictions you provide in your custom code.

Extending a GroupSpace Community could also involve adding functionality. For example:

Using the GroupSpace controls, you could develop a portlet that performs tasks in 
customized ways.

You can access the number of times specific predefined GroupSpace events occur, letting 
you perform custom analytics.

The following sections describe some of the ways you can extend the default GroupSpace 
Community template.
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Understanding Which Files to Not Modify
Modifying certain files could cause GroupSpace to function incorrectly. Do not modify the 
following GroupSpace resources:

The GroupSpace.usr user profile property set in the <datasync 
project>/src/userprofiles directory.

Any directories or content in the Virtual Content Repository located under 
Community_Repository/GroupSpace, 
Community_Repository/CmxControlUniqueKeysFolder, 
Community_Repository/users.

The following properties in the .ctmeta file: callback-class, registration-uri, error-uri, and 
inviter-invoker-class.

Copying Source Files from the Library
If you want to modify resources used in GroupSpace, copy those resources from the shared 
library. When you copy resources from a library to your file system, the file system copies take 
precedence over the library resources.

Perform the following steps to copy GroupSpace resources from the shared library:

1. Switch to Merged Projects view (included with the Portal perspective).

2. Right-click any available shared library resources (they appear in italic font), and select Copy 
to Project.

3. Switch to the Navigator view and open the resources for modification.

To return to using the shared library versions of any files, delete the files from the Navigator view. 
Before you delete a file, verify that it is a file that is stored in the shared library. Some files 
provided in GroupSpace are not included in the shared library and will be permanently deleted if 
you delete them in the Navigator view.

Changing the Text of the GroupSpace Invitation E-mail
If you want to modify the e-mail text that is sent for invitations to a Community, modify the 
/invitations/email/invite_body.jsp and invite_subject.jsp files.

When you modify either of these files, you must restart the server for the changes to take effect.
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Modifying the groupspace.community File
The groupspace.community file, located at 
<portalWebProject>/<WebContent>/groupspace.community, is a portal file with a 
.community extension. It contains the full set of GroupSpace features and can be used as is for 
creating GroupSpace Communities.

You can modify this file to suit your needs. For example, if you do not want the Mail portlet to 
be included in GroupSpace Communities that are created from this file, you can remove the 
portlet in the portal editor.

However, modify this file only for simple changes. If you want to make major modifications to 
this file, make a copy of it or create a new Community file and make more extensive 
modifications to it.

Modifying the groupspace.ctmeta File
The groupspace.ctmeta file, located at 
<portalWebProject>/<WebContent>/groupspace.ctmeta, is a Community template 
metadata file that provides default settings (many of them advanced) for a Community template. 
Portal administrators use this file to quickly and easily create Community templates, which in 
turn are used to create Communities that have those settings. Among other settings, this file 
specifies groupspace.community as the .community file that is used for the Community.

You can modify this file to suit your needs. For example, if you create a new .community file 
that you want to use as a basis for new Communities, you can reference that file in the .ctmeta 
file.

If you want to retain the original groupspace.ctmeta file, you can make a copy of the 
groupspace.ctmeta file or create your own .ctmeta file.

You can change any settings in this file. However, for GroupSpace to work correctly, do not 
change any of the following properties:

The callback-class

The registration-uri

The error-uri

The inviter-invoker-class

See “Community Properties Reference” on page 4-12 for .ctmeta property descriptions.
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Modifying GroupSpace Security Capabilities
GroupSpace provides the following security capabilities, or role names: creator, owner, 
contributor, and viewer. (Creator and owner are provided by default in every Community, even 
non-GroupSpace Communities.) GroupSpace uses these capabilities to control create, read, 
update, and delete actions performed by users in GroupSpace.

These capabilities are defined in the /META-INF/communities-config.xml file in the 
GroupSpace shared library. You cannot modify this file. However, you can add capabilities to 
your <portalEARproject>/META-INF/communities-config.xml file and develop custom 
functionality that uses those capabilities.

Users with Community management rights can also override capability rights in the Community 
Tools. For example, a Community administrator can add “update” rights to viewers. The updated 
capability settings are stored in the database.

Consider the following when modifying Community capabilities:

Adding a Role to GroupSpace – Even if a new role you add has full create, read, update, 
and delete capabilities, the role cannot manage an existing Community. But this role can 
create and manage a new Community.

Modifying Existing Capabilities – Modifying existing capabilities does not change the 
capabilities for existing Communities, but new Communities use the modified capabilities.

A GroupSpace Community defines rights for each of its default capabilities: creator, owner, 
contributor, and viewer. If you modify any of the rights for a capability in the Community Tools, 
those rights modifications are stored in the database and override the default rights.

Using GroupSpace Controls
GroupSpace provides many convenience controls that you can add to your Page Flows. These 
controls let you develop many types of GroupSpace functionality and provide powerful search 
capabilities.

Perform the following steps to add a GroupSpace control to a Page Flow:

1. Open the Page Flow controller and switch to the Page Flow Explorer view (available in the 
Page Flow perspective).

2. Right-click Referenced Controls and choose Add Control.

3. In the Select Control window, expand the appropriate Portal GroupSpace controls group, 
select the control you want to use, and click OK.
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4. The control appears under Referenced Controls, where you can expand it and drag the actions 
you want into the page flow.

For API-level information on GroupSpace controls, see 
com.bea.apps.groupspace.*.controls in Javadoc.

Using the GroupSpace API
GroupSpace provides a rich API for developing custom GroupSpace functionality. Functionality 
developed using the GroupSpace API can be used only in the context of a GroupSpace 
Community. For example, if you develop custom GroupSpace RSS portlet using the 
com.bea.apps.groupspace.rss.feed.Feed class, that portlet will not work in a 
non-GroupSpace Community.

For details on the GroupSpace API, see the com.bea.apps.groupspace.* packages in 
Javadoc.

Adding Your Own Community Portlets
You can add custom-built portlets to your GroupSpace Community. Develop a portlet that 
contains the functionality you want, using such resources as the GroupSpace controls and the 
Community framework API, then add the portlet to the .community file to which you want it to 
belong.

Any portlet you develop using the Community framework API can run only in the context of a 
Community. Likewise, any portlet you develop using the GroupSpace API can run only in the 
context of a GroupSpace Community.

Using GroupSpace Events
GroupSpace includes many predefined events that are automatically triggered as users interact 
with a GroupSpace Community. As each event is fired, the event is added to a buffer by a 
predefined event listener. When the buffer is flushed to the database, the count for each type of 
event that has occurred is updated. GroupSpace tracks only the number of times each type of 
event occurred.

GroupSpace automatically tracks create, read, update, and delete operations on GroupNotes, 
Links, Doc Library, Issues, and RSS channels. GroupSpace does not currently track: Links, view 
and delete; Doc Library, create and update; and RSS channels, view.

The counts are stored in 
Community_Repository\Groupspace\<AppName>\<WebApp>\<CommunityName>\groupsp

../javadoc/index.html
../javadoc/index.html


Work ing  wi th  GroupSpace  in  Deve lopment

4-12 BEA WebLogic Portal GroupSpace Guide

ace\ Analytics\ <EventName>. For example, \Groupspace\myPortalEAR\ 
myPortalWebProject\myGroupSpace\groupspace\Analytics\ 

LoginEventx295rf29v6ljstcmjryfey3dhysvdlo. You can use WebLogic Portal's content 
management API to access the event counts for your own analytical purposes.

The event listener (com.bea.apps.groupspace.analytics.listeners. 
AnalyticEventListener) is registered as an asynchronous listener in the Administration 
Console. Choose Configuration & Monitoring > Service Administration. Expand the 
Personalization folder and select Event Service. If you want to stop tracking event counts, you 
can unregister the listener.

Use the following guidelines for best performance:

Leave the event listener configured as asynchronous.

In conjunction with the buffer, the GroupSpace event service uses a timer, set to a default 
length of one minute. When the timer goes off (or when the buffer reaches capacity), any 
events in the buffer are written to the database. You can configure the timer in the web.xml 
file.

See the Interaction Management Guide for more information on listener classes.

Community Properties Reference
Community properties are set in the following ways:

In development, when developers create .ctmeta files that portal administrators use to 
create Community templates and Communities.

In production, when portal administrators create Community templates based on library 
resources or .portal files.

In production, when end users create Communities based on existing Community 
templates.

The following items describe Community properties: 

Title – The default name of the Community that appears in the user interface. The title can 
be overridden by the localized Community title.

Description – The default description of the Community that appears in the user interface. 
The description can be overridden by the localized Community description.

Allow non-members to access this community – If set to true (checked), anyone can 
access the Community without registering as a member.

../interaction/index.html
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Allow anyone to register for community membership – If set to true (checked), anyone 
can register as a member in the Community without first receiving an invitation.

Allow people to customize their view and add personal pages – If set to false 
(unchecked), the Visitor Tools are disabled in the Community. Community administrators, 
however, can still access the Community Tools.

Registration Uri/Page – The path to the Community registration page, usually the home 
page for a Community.

Error Uri/Page – The path to the error page that is displayed when a user is not allowed 
access a Community; for example, if the user is not a member or the Community is 
disabled.

Expiration Date - The date when the Community will automatically become inactive.

Make this community active now / Status – If set to Inactive, only Community members 
with an administrative capability can access the Community.

Track member visits to this community – If set to yes, the number of times members 
visit the Community is stored in the virtual content repository.

Callback Class – The name of the class (including the package path information) that 
performs special tasks when the Community is created, activated, deactivated, or deleted. 
For example, the GroupSpace callback class is 
com.bea.apps.groupspace.security.GroupSpaceCallbackImpl. Your development 
team may provide its own callback class.

Enable Tree Optimization – If set to true, improves Community performance. For more 
information on this feature, see Designing Portals for Optimal Performance in the Portal 
Development Guide.

Analyzing GroupSpace Events
A GroupSpace Community includes several predefined events that are automatically triggered as 
users interact with a GroupSpace Community. As each event occurs, the event is captured by a 
predefined event listener and stored in a buffer. When the buffer information is written to the 
database, the count for each type of event that occurred is updated.

The events are not visible in the UI, but you can view and analyze the events later. The ability to 
capture and store events is on by default, and these events must occur within a GroupSpace 
Community. 

../portals/index.html
../portals/index.html
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GroupSpace Community events automatically track the following create, read, update, and delete 
operations for the portlets listed in Table 4-1.

The events are asynchronous events and are stored in the Community Repository in the following 
location: \Community_Repository\Groupspace\<AppName>\<WebApp>\ 
<CommunityName>\Analytics\<EventName>. For example, \Groupspace\myPortalEAR\ 
myPortalWebProject\myGroupSpace\Analytics\LoginEventx295rf29v6ljstcmjryfey

3dhysvdlo. You can use WebLogic Portal's content management API to access the event counts 
for your own analytical purposes.

The pre-configured event listener (com.bea.apps.groupspace.analytics.listeners. 
AnalyticEventListener) is registered as an asynchronous listener in the Administration 
Console. (Choose Configuration & Monitoring > Service Administration, and then expand 
the Personalization folder and select Event Service.) 

The event listener is located in the p13-config.xml file. If you want to stop tracking event 
counts, you can unregister the listener. The event information that is stored for each Community 
is the event name, the count, and the date. See the Interaction Management Guide for more 
information on listener classes.

For best performance, use the following guidelines:

Leave the events as asynchronous events; do not modify the events to be synchronous.

The GroupSpace event service uses a buffer (to store the event information) and a timer. 
When the timer goes off, it automatically writes the buffered events to the database. The 

Table 4-1  Predefined Events that Are Captured and Stored

Create Read Update Delete

GS Links X X

GS Document Library X X

GS Issues

GS RSS Reader X

GroupNotes

../interaction/index.html
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timer’s default is one minute; you can configure the length of the timer in the web.xml 
file.

Changing the GroupSpace Look & Feel
Look & Feel determines the appearance of your GroupSpace Community, from the placement 
and behavior of elements on a page to the colors used in the portlet title bars. 

A Look & Feel file (.laf) is an XML block that is inserted into the overall .portal XML file. 
The Look & Feel file references a specific skin and skeleton. The skin provides a set of images, 
JavaScript functions, and CSS files, which are referenced by the skeleton JSPs that convert the 
portal XML components to the final HTML output. See the Portal Development Guide for more 
detail on Look & Feel, skins, and skeletons.

WebLogic Portal ships with several different Look & Feel files that do not work within a 
GroupSpace Community. This is due to implementation details of the A GroupSpace Community 
is tightly coupled with the GroupSpace custom Look and Feel (gsdefault).

Choose one of two ways to change the Look & Feel of your GroupSpace Community:

1. Modify the existing Look & Feel by overriding what is provided in the library modules

2. Create a new Look & Feel by duplicating the default GroupSpace Look & Feel and editing it. 
This method leaves the original Look & Feel, unless you block it with entitlements.

Tip: Only the GroupSpace Default (gsdefault) Look & Feel is compatible with GroupSpace; 
you should make all other Look & Feel files (Default, Classic, All Text, and Legacy) 
unavailable to users. The best way to do this is to create an entitlement role to which that 
no one belongs, and then entitle the other Look & Feel files so that they are available only 
to that role. Leave the GroupSpace Default Look & Feel unentitled so that it is available 
to all users.

This section contains the following topics:

Modifying the Default GroupSpace Look & Feel

Creating a New GroupSpace Look & Feel

Modifying the Default GroupSpace Look & Feel
The following steps describe how to modify one part, the GroupSpace logo, of the default 
GroupSpace Look & Feel.

../portals/index.html
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Perform the following steps to modify the default GroupSpace Look & Feel:

1. In WorkSpace Studio, verify that the Visitor Tools project facet is installed in your portal web 
project. See Enabling Visitor Tools in the Portal Development Guide for instructions on 
enabling a new Look & Feel.

2. Choose Window > Show View > Merged Projects. The Merged Projects view provides a 
virtual view of your project where items in italics are located in the library modules that ship 
with WebLogic Portal, and other items physically reside in your project directory. Items in 
your project directory will be used instead of library module items if they have the same name 
and path. WebLogic Portal provides the ability to create an overriding local copy of a file from 
a library module.

3. Expand the following italicized directories in your portal web project directory: framework 
> skins > gsdefault > images, as shown in Figure 4-1.

Figure 4-1  The images Directory

4. For example, right-click the italicized header-logo.gif file in the /images directory and 
choose Copy to Project. The item is no longer italicized because your project has a local copy 
of the file that will be used instead of the library module version.

../portals/vistools_config.html
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5. Right-click your copy of the file and choose Properties to see where the file is located on your 
local disk, or right-click the file and choose Show In > Navigator to see the local file in an 
unmerged view of your project.

6. Edit your local copy of the header-logo.gif file in any image editor, as shown in 
Figure 4-2. Save your changes.

Figure 4-2  Edit the header-logo.gif File

7. Access the GroupSpace Community in your browser to view the changes. If you do not see 
the changes, the old image may be cached by the browser. Refresh your browser to reload all 
the images and the CSS.

8. Perform these same steps to modify other Look & Feel and CSS files. Be careful changing 
these files as edits can affect other functionality in your GroupSpace Community. Test your 
changes often.

Creating a New GroupSpace Look & Feel
You can create a new GroupSpace Look & Feel based on the default gsdefault.laf file. (See 
the Portal Development Guide for instructions on creating other new Look & Feel files.)

Perform the following steps to duplicate the entire GroupSpace Default Look & Feel and edit it 
to create your own Look & Feel:

1. Verify that the Visitor Tools project facet is installed in your portal web project. See Enabling 
Visitor Tools in the Portal Development Guide for instructions on enabling a new Look & 
Feel.

2. In the Merged Projects View, expand the /framework/skins directories so you can see the 
/gsdefault directory.

3. Right-click the /gsdefault directory and choose Copy to Project.

../portals/index.html
../portals/vistools_config.html#wp1027706
../portals/vistools_config.html#wp1027706
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4. On your local disk, rename the gsdefault directory (under your project's /framework/skins 
directory) to a new Look & Feel name. Do not use spaces in the name.

5. In the Merged Projects View, expand the /framework/markup/lookandfeel directories so 
you can see the gsdefault.laf file.

6. Right-click gsdefault.laf and choose Copy to Project.

7. On your local disk, rename the gsdefault.laf file (in your project's 
framework/markup/lookandfeel directory) to match your new Look & Feel name from step 4.

8. Edit your new .laf file: change the title, description, definitionLabel, markupName (to 
match the definitionLabel), and skin (to match the name in step 4 & step 7) and save your 
changes. Do not change the skeleton, skeletonPath, or skinPath.

9. Redeploy the application and restart the server to see your new Look & Feel. The new Look 
& Feel should be available in the Customize > Colors menu in your GroupSpace 
Community.

10. Edit the images and CSS in your new /skin directory to make changes.

The skin also references the CSS and images in the /<yourproject>/wlpAppsCollaborationCore 
directory. You may want to make local copies of certain files there, or the whole directory. 
Javascript exists in the directory; take care if you decide to replace the entire directory with a 
renamed directory, rather than just overriding certain files.

Tip: If you edit your skin.xml file (for example, to import a new CSS file into your new Look 
& Feel), do not change the skeletonid or skeleton-path. Changing the skeleton can cause 
it to break; use the gsdefault skeleton that ships with WebLogic Portal.

Setting Up the Rich Text Editor
Some GroupSpace portlets have a rich text editor to apply formatting to documents or other items. 
Portal Administrators can allow users to access a portlet’s formatting toolbar and a bottom 
toolbar, which lets them view the item’s HTML text or preview the item.

For example, enabling rich text editing in the GS Issues portlet allows users to use the formatting 
toolbar to apply bold, Italic, indentations, colored fonts, and so on. Enabling the bottom toolbar 
in the GS Issues portlet lets users see and use the HTML, Edit, and Preview buttons.

You can enable or disable the rich text editor settings for the following portlets:



Se t t ing  Up  the  R ich  Tex t  Ed i to r

BEA WebLogic Portal GroupSpace Guide 4-19

GS Issues

GS GroupNotes

GS Announcements

Calendar

Tasks

AddressBook (in the Contacts portlet)

Mail

Discussion Forums

Enabling Rich Text Editing 
The GS Example Community has the rich text editor enabled by default and the bottom toolbar 
disabled. For all other web applications, the System Administrator must edit the web.xml file to 
enable the rich text editor and the bottom toolbar, and then the Portal Administrator sets the 
portlet preferences.

Perform the following two steps to enable the rich text editor:

1. The System Administrator uses a text editor to edit the web.xml file in your /WEB-INF 
directory and add the required context parameters and values, as shown in Listing 4-2. After 
you edit the file, restart the WebLogic server. Use the following guidelines to determine how 
to set the values in the web.xml file:

– If the rich text editor (RichTextEditorEnabled)value is set to false in the web.xml 
file, rich text editing is not enabled and the bottom toolbar is not enabled and does not 
appear in the portlet. You cannot override the settings in the Administration Console, as 
described in step 2.

– If the bottom toolbar (RichTextEditorHTMLToolBarEnabled) value is set to false 
in the web.xml file, and the rich text editor value is set to true, rich text editing is 
enabled, but not the bottom toolbar. The bottom toolbar does not appear in the portlet. 
You cannot override the bottom toolbar settings in the Administration Console.

– If the bottom toolbar value is set to true but the rich text editor is set to false, the 
bottom toolbar is not enabled and rich text editing is not enabled. You cannot override 
the settings in the Administration Console.
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Listing 4-2   Add Context Parameters and Values to the End of the web.xml File

<context-param>

     <param-name>com.bea.apps.groupspace.RichTextEditorEnabled</param-name>

    <param-value>true</param-value>

</context-param>

<context-param>

    <param-name>com.bea.apps.groupspace.RichTextEditorHTMLToolBarEnabled

         </param-name>

    <param-value>true</param-value>

</context-param>

<context-param>

    <param-name>collaboration.RichTextEditorEnabled</param-name>

    <param-value>true</param-value>

</context-param>

2. After the context parameters are added to the web.xml file, the Portal Administrator uses the 
Administration Portal to modify portlet preference settings for each portlet. See Modifying 
Portlet Preferences for Rich Text Editing.

Modifying Portlet Preferences for Rich Text Editing
You can use portlet preferences to control the rich text editor and the bottom toolbar for individual 
portlets.

WARNING: If the web.xml file’s rich text editor values are set to false, any edits you make 
to portlet preferences in the Administration Console are ignored. If the rich text 
editor value is false, but the bottom toolbar value is set to true, the toolbar does 
not appear in the portlet.

Perform the following steps in the Administration Console to change portlet preferences for rich 
text editing and the bottom toolbar:

1. In the Administration Console, choose Portal > Portal Management.

2. In the Portal Resources tree, expand the Library folder and the Portlets folder.

3. Click Next or Prev to locate the portlet you wish to modify and select it so that it is 
highlighted, as shown in Figure 4-3.
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Figure 4-3  Select the Portlet Whose Preference You Want to Modify

4. After you select the portlet, click Portlet Preferences.

5. Locate the preference you want to change, as shown in Figure 4-4. 

Figure 4-4  Click Edit to Change a Preference

6. The GS Issues, GS GroupNotes, and GS Announcement portlets contain a preference called 
RichTextEditorEnabled. Verify that the preference’s setting is true, to allow the portlet 
to display the rich text editor. If this preference is set to any value other than true, the portlet 
displays a simple text area for entering information. Other portlets (Address Book in 
Contacts, Mail, Calendar, Tasks and Discussion Forums), also have preferences to enable the 
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rich text editor, but they are named differently that the GS portlets. After you locate the portal 
preference you want to change, click Edit.

Select the Is Modifiable check box for the RichTextEditorEnabled preference to allow 
users to modify this preference. Do not select the Is Multi-valued check box. Click Save.

Figure 4-5  The Rich Text Editor in a Portlet

Tip: By default, the GS Example Community that ships with WebLogic Portal has the rich 
text editor formatting toolbar enabled, and the bottom toolbar is disabled. For other 
web projects, the default is that rich text editing is not enabled for any of the portlets.

7. You can also change the preference that controls the display of the bottom toolbar. For 
example, if you change the GS Issues RichTextEditorHTMLToolBarEnbled preference to 
true, the portlet displays the bottom toolbar when the rich text editor is available. The toolbar 
controls the Edit, HTML, and the Preview buttons. Clicking HTML allows a user to enter 
HTML directly into the text area. See Figure 4-6.

Figure 4-6  The Bottom Toolbar in a Portlet that Allows Rich Text Editing

8. Other portlets might contain other preferences that you can set. For example, the Mail portlet 
has a collaboration.max.attachment.size preference to control the size of mail 
attachments that users can send or receive.

9. After making your changes to the portlet preferences, click Save to see the change appear in 
your portlet in your Community desktop. If you made preference changes at the library level, 
click Propagate to Instances to force proliferation of this preference to every instance of this 
portlet. WebLogic Portal overwrites all desktop instance’s preferences with the library 
preferences. For more information on propagating to instances, see the Portlet Development 
Guide. 

../portlets/index.html
../portlets/index.html
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Searching for Microsoft Word, Excel, and PowerPoint 
Files in Multibyte Languages

You can configure search and indexing for Microsoft Word (.doc), Excel (.xls), and PowerPoint 
(.ppt) files in Content Management and GroupSpace communities. For information on how to do 
this see “Enterprise Search for Microsoft Word, Excel, and PowerPoint Files in Multibyte 
Languages” in Multi-language Searching and Indexing in Integrating Search.

../search/multilang.html
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Part III Staging

Part III includes the following chapter:

Chapter 5, “Creating a GroupSpace Community Template”

During the Staging phase, you use the Administration Console to create a GroupSpace 
Community template.

For a description of the Staging phase of the portal life cycle, see the WebLogic Portal Overview. 
The portal life cycle is shown in the following graphic:

../overview/index.html
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C H A P T E R 5

Creating a GroupSpace Community 
Template

After you create a GroupSpace-enabled web application in WorkSpace Studio (see Chapter 4, 
“Working with GroupSpace in Development”), use the Administration Console to create a 
GroupSpace Community template. A Community template is a packaged set of resources you can 
use to build a project management or collaboration application. You can create a GroupSpace 
Community template and use that template to create a new GroupSpace Community without 
writing additional code.

When you create a Community template, you can choose to use an existing Community template 
or Community template metadata file, you can select resources in the library, or you can use a 
.portal file. The most common method is to use an existing .ctmeta file to create your 
Community template. If you are creating a GroupSpace Community, you must use an existing 
.ctmeta file.

This chapter contains the following topics:

Creating a GroupSpace Community Template

Creating a GroupSpace Community Template
See the QuickStart: Creating a GroupSpace Community chapter.

Propagating GroupSpace Communities
You cannot propagate a GroupSpace Community from staging to production. You can only 
propagate Community templates.

quickstart.html
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Part IV Production

Part IV includes the following chapters:

Chapter 6, “Managing GroupSpace”

Chapter 7, “Using the GroupSpace Portlets”

The Production phase allows you to create your GroupSpace Community, send invitations to 
users, edit roles, and customize the look and feel of the Community.

Some of the tasks you can perform in the Production phase include the following:

Re-create the GroupSpace Community you created in the Staging phase

Log in to accept your invitation to join the GroupSpace Community

Invite other users to join

Edit roles and capabilities

Customize the look and feel of your GroupSpace Community

Use the GroupSpace Community portlets to collaborate and share information

The GroupSpace Community uses the template that you created in the Staging phase. The 
Propagation Utility moves the GroupSpace Community template that you created in the Staging 
phase to your Production environment, but it does not move the GroupSpace Community itself. 
You must re-create the Community in your Production environment. See the Production 
Operations Guide for more information on deployment and propagation.

../prodOps/index.html
../prodOps/index.html


For a description of the Production phase of the portal life cycle, see the WebLogic Portal 
Overview. The portal life cycle is shown in the following graphic:

../overview/index.html
../overview/index.html
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C H A P T E R 6

Managing GroupSpace

The Propagation Utility does not move the GroupSpace Community that you created in the 
Staging phase to your Production environment, so you must re-create the Community in your 
Production environment.

This chapter contains the following topics:

Creating a GroupSpace Community

Setting Visitor Entitlements on GroupSpace Resources

About Custom Community Properties

Managing GroupSpace Content

Creating Localized Community Titles and Descriptions

Deactivating or Deleting a Community

Propagating Communities

Logging In

Inviting Users to Join

Editing Roles and Capabilities

Managing the GroupSpace Portlets

Customizing Your GroupSpace Community
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Customizing Template JSPs

Creating a GroupSpace Community
See the QuickStart: Creating a GroupSpace Community chapter.

Setting Visitor Entitlements on GroupSpace Resources
Do not manually set visitor entitlement roles on GroupSpace resources. GroupSpace provides its 
own mechanism for controlling user access to its resources. Manual entitlement settings could 
interfere with the normal operation of GroupSpace.

About Custom Community Properties
Do not modify any of the default GroupSpace custom properties on your GroupSpace 
Community’s Custom Properties page in the Administration Console. These properties support 
programmatic operations in GroupSpace. Modifying any of these properties could interfere with 
the normal operation of GroupSpace.

Managing GroupSpace Content
GroupSpace Communities use the Community_Repository and specific content types to store 
content. Almost every item in GroupSpace, from an Issue to a calendar appointment, is stored as 
content in Community_Repository, and access is controlled through predefined Visitor 
Entitlements. As users interact with the GroupSpace Community, the application automatically 
adds to, modifies, and entitles content in the Community_Repository.

WARNING: Because of the automated nature of GroupSpace's interactions with 
Community_Repository, do not make manual modifications to the 
Community_Repository or its types (unique keys), especially by modifying 
Visitor Entitlements. It is recommended that you set delegated administration on 
the Community_Repository so that only specific portal administrators can view it.

Creating Localized Community Titles and Descriptions
You can provide localized text for the title and description of your Communities. When you 
provide localized text, and a browser is set to use a language you provide, the localized title and 
description of that Community appear in that browser, either in the Administration Console or in 

quickstart.html
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the Community itself. For example, in GroupSpace, localized titles appear in the GroupSpace 
header.

If you want to use double-byte characters, such as Chinese, make sure your system is configured 
to support this.

You can also use this feature to provide an alternative Community name and description in 
English, changing them as often as you like.

1. In the Portal Resources tree in the Administration Console, select the Portals directory, 
yourPortal, Communities, and yourCommunity.

2. On the Title & Description page, click Add Localized Title.

3. In the Add a Localized Title & Description window, enter:

– Language (required) – The two-letter code for the language. For example, zh for 
Chinese.

– Country (optional) – The name of the country.

– Variant (optional) – The two-letter language variant in uppercase, such as US for the 
United States English, or TW for Taiwan Chinese.

– Title (required) – The localized title you want to provide.

– Description (optional) – The localized description you want to provide.

4. Click Create.

To modify an existing title and description, such as changing the English text, click the language 
link and modify the title and description.

Deactivating or Deleting a Community
If you want to prevent users from accessing a Community, you can either deactivate or delete the 
Community. Reasons to deactivate a Community include wanting to prevent user access while 
you configure it, archiving it, or wanting to activate it again in the future. Deleting a Community 
permanently removes it from the database.

Deactivating a Community
To deactivate an active Community, which prevents users from accessing the Community:
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1. In the Portal Resources tree, select the Community you want to deactivate by selecting the 
Portals directory, yourPortal, Communities, and yourCommunity.

2. On the Summary page, click Status & Expiration.

3. In the Status & Expiration dialog, select Inactive and click Update.

or

4. If you want to deactivate the Community on a specific date, select Active, set the Expiration 
Date for when it should automatically be deactivated, and click Update.

The callback class assigned to the Community determines what occurs when the Community is 
deactivated. For example, notifications can be sent to users when a Community is deactivated.

Deleting a Community
Deleting a Community permanently removes it from the database.

Perform the following steps to delete a Community:

1. In the Portal Resources tree, select the Portals directory, yourPortal, and Communities. 

2. On the Browse page, select the Delete check box next to the Community.

3. Click Delete.

Propagating Communities
You cannot propagate a Community back to staging or development. You can only propagate 
Community templates.

Logging In
After you or another user receive an invitation to join a GroupSpace Community, you can log in 
and become a member.

Perform the following steps to log into the GS Example Community:

1. Go to http://<localhost>:7041/groupspace/groupspace.jsp. Insert your machine 
name for <localhost>. 

2. Enter your Username and Password and click Login. (If you created the GroupSpace 
Community, log in as weblogic/weblogic.)
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3. In the GroupSpace Invitations section, click the GroupSpace Community name.

4. In the Community Registration page, enter your personal information and click Save and 
Continue or click Skip. 

Inviting Users to Join
After you create your own GroupSpace Community, you can invite other users to join the 
GroupSpace Community. You can also assign Community members to a role to control what they 
can do, use portlet settings to control who can view a portlet’s data, and set portlet preferences.

Note: To successfully use the Invitation wizard (discussed in the section, “Sending an 
Invitation to Join the Community” on page 6-7), you must be entitled to view the users 
you want to invite. The best general practice is to assign to one or more groups the users 
that you want to include in the pool of potential users to invite to the community, and then 
entitle those groups with a role that has the View capability. For details on creating visitor 
entitlements, see the Security Guide. For information on creating groups, see the User 
Management Guide. 

The benefit of joining a GroupSpace Community is that users who belong to the same 
Community can work together and share information and resources.

The ability to access a GroupSpace Community is based on Community properties and 
membership. If anyone can access a GroupSpace Community, the Community is public. If you 
are required to register, the Community is private and you are redirected to a registration page. 

The following two ways allows users to join a Community:

1. Invitations – GroupSpace creators and owners send an e-mail Invitation to invite users to join 
the Community. Prospective Community members must each receive their own unique 
invitation. See “Inviting Users” on page 6-6.

2. Self-registration – If Public Registration exists, visitors can register to join the Community 
without an Invitation. The capability of each new self-registered user depends on what you 
set up (choose Communities > Manage This Community and select the Security tab.) The 
default capability for a user that self-registers is Contributor. See Figure 6-1.

../security/index.html
../users/index.html
../users/index.html
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Figure 6-1  Set the Default Role

Inviting Users
Accessing a Community is based on Community properties and membership. The following two 
related properties affect Community access:

Access – If anyone can access this Community, the Community is public. If you are 
required to register, the Community is private and you are redirected to a registration page.

Joining – If Public Registration exists, visitors can register to join the Community without 
an Invitation. The capability of each new self-registered user will have depends on what 
you set up in the security mapping page (choose Communities > Manage This 
Community and select the Security tab). The default capability for a user that 
self-registers is Contributor. You can also set up the Community so that only invited users 
can join.

GroupSpace creators and owners can invite users through e-mail to join the Community. 
Prospective Community members must each receive their own unique invitation. Users that 
belong to the same Community can work together and share information and resources.

This section contains the following topics:

Sending an Invitation to Join the Community

Accepting an Invitation

Removing a Member
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Sending an Invitation to Join the Community
You can invite users to join the GroupSpace application. You must first configure your outgoing 
mail server to be able to send e-mail invitations. 

Note: To successfully use the Invitation wizard (discussed in step 5 below), you must be 
entitled to view the users you want to invite. The best general practice is to assign to one 
or more groups the users that you want to include in the pool of potential users to invite 
to the community, and then entitle those groups with a role that has the View capability. 
For details on creating visitor entitlements, see the Security Guide. For information on 
creating groups, see the User Management Guide. 

Perform the following steps to invite someone to join the GroupSpace Community:

1. Log into the GroupSpace application as a Community owner or creator.

2. Choose Communities > Manage This Community.

3. Configure your outgoing e-mail server to be able to send e-mail invitations by selecting the 
Properties Page tab and clicking Community Email Configuration and enter the following 
information to set up your outgoing mail server. Each field is required.

– Reply-to Address – Your username.

– Display Name – The name you want to appear in the From field of the e-mail.

– Outgoing Mail Server (smtp) – Your server name.

– Outgoing Mail Port (smtp) – The port to connect to the incoming mail server. This 
defaults to the value for the selected protocol. For SMTP, enter 25.

– Account username (smtp) – Enter the account’s username. For example, groupspace.

– Account password (smtp) – Enter the account’s password for the incoming mail 
server.

4. Select the Members Page tab and click Invite More People.

5. In the Invite Members to Community: Step 1 dialog in the Invitation wizard, use the 
drop-down list to select users or groups to invite. 

– Type username or e-mail address – Manually type each existing username or e-mail 
address.

– Browse All Available Users – Select a user from the list. If the list is long, you can 
search for the user’s name. The search is case sensitive.

../security/index.html
../users/index.html
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– Browse All Available Groups – Select a group from the list. The Visitor Entitlements 
you set up for your portal determine which groups appear here. If the list of groups is 
long, you can search for a group name. The search is case sensitive. For more 
information on Visitor Entitlements, see the Security Guide.

– Your current Communities – Select a user from the list. The list contains other 
Community members from all the Communities to which you belong.

Click Add to move the user or group to the Users or Groups to Invite section (see 
Figure 6-2) and click Next. (If you use a username, the user must have a User Profile 
created.)

Figure 6-2  Use the Drop-Down List to Select Who to Invite to the GroupSpace Community

6. In the Invite Members to Community: Step 2 dialog, assign a role by selecting one of the 
check boxes and clicking Next. See “Editing Roles and Capabilities” on page 6-11 and 
“Editing Default Role Capabilities” on page 6-14 for more information on roles. See 
Figure 6-3.

../security/index.html
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Figure 6-3  Assign a Role to the Person You Are Inviting

7. In the Invite Members to Community: Step 3 dialog, enter your name in the Send Invitation 
from field, type a message, and click Next.

8. In the Invite Members to Community: Step 4 dialog, review the invitation and click Finish.

9. Click Close to exit the Invitation wizard. The people you invited will receive an e-mail with 
a link to the GroupSpace Community you created. The members must log in to accept the 
invitation.

Tip: You can view Invitations that have been sent on behalf of the Community that have not 
been accepted. Choose Communities > Manage This Community and select the 
Invitations tab to see Invitation details and status. Status includes sent, accepted, 
rejected, revoked, or expired invitations. You can select the Cancel Invitation check box 
next to a pending Invitation and click Remove to cancel the Invitation.
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Accepting an Invitation
When a member receives an invitation and decides to join a Community, the member must go to 
the provided GroupSpace Community URL and accept the invitation.

Perform the following steps to accept an invitation to join a Community:

1. Open the e-mail you received that invited you to join a GroupSpace Community.

2. In the e-mail, click the URL for the GroupSpace Community that you were invited to join.

3. In the Community Registration page, click Need to create a login.

4. Enter a Username and a Password. Retype the password in the Confirm password field and 
click Create Account.

5. In the Community Registration page, click the link to the Community.

Removing a Member
A GroupSpace owner or creator can remove members from the Community. Removing a member 
deletes the user’s membership, but does not delete the user.

Perform the following steps to remove a Community member:

1. Log into the GroupSpace application as an owner or creator.

2. Choose Communities > Manage This Community, as shown in Figure 6-4.

Figure 6-4  Choose Manage This Community

3. Select the Members Page tab.

4. Locate the member and select the Remove check box.

5. Click Remove.
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Editing Roles and Capabilities
The GroupSpace Community administrator sets up the roles to control what users can do in the 
Community. Each role has specific, defined capabilities. A content item can be a folder or an item 
in the folder. 

The GroupSpace application contains the following capabilities:

Create (C) – Can add content items

Update (U) – Can modify the content item’s properties

Delete (D) – Can delete content items

View (V) – Can see content items and their properties

The GroupSpace application’s roles and default capabilities are listed in Table 6-1. You can 
change the default capabilities (except for View, which is always enabled). The default 
membership role is Contributor. A GroupSpace Community member can have more than one 
role. See “Editing Default Role Capabilities” on page 6-14 for more information.

A user’s capability can be tied to the Active Menu that you see when you hover your mouse over 
an item (an Issue, for example) and click the arrow that appears. If your assigned capabilities 
include the ability to delete items, you will see the Delete choice, as shown in Figure 6-5.

Table 6-1  Roles and Default Capabilities

Role Purpose Capability

Creator Create a GroupSpace Community, and create, 
update, and delete content

C,U,D,V

Owner Manage a GroupSpace Community, and create, 
update, and delete content

C,U,D,V

Contributor Can create and update content C,U,V

Viewer View content V
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Figure 6-5  This User has Create, Update, Delete, and View Capabilities, as shown in the Active Menu

For instructions on editing the XML file that controls the Active Menu capabilities, see the 
Communities Guide.

A system administrator at your company can use the Administration Console to modify the 
GroupSpace Content Repository and control the visibility of content for all GroupSpace 
Communities. See the Content Management Guide for more information.

This section contains the following topics:

Assigning a Role to a Member

Editing Default Role Capabilities

Assigning a Role to a Member
A GroupSpace Community owner or creator can assign a role to each member.

Perform the following steps to change the role a member is assigned:

1. Log into the GroupSpace application as an owner or creator.

2. Choose Communities > Manage This Community.

3. Select the Members Page tab. The Members Page is shown in Figure 6-6.

../communities/index.html
../cm/index.html
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Figure 6-6  Roles for Users

4. Locate the member and click Edit.

5. Select the check box for a role that you want to assign to the member and click Update, as 
shown in Figure 6-7. Select only one role for each member.

Figure 6-7  Assign Roles to a Member

6. Click Update and close the window.
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Tip: To assign all your users the same role, click Assign To All at the bottom of the column 
in the Members Page tab.

An anonymous user is a user that has not logged in and does not have a role in the GroupSpace 
Community. Anonymous users cannot see the data in the GroupSpace portlets.

Editing Default Role Capabilities
GroupSpace administrators can change the default capabilities that are assigned to each 
GroupSpace Community role.

Perform the following steps to change what a role can do:

1. Log into the GroupSpace application as an owner or creator.

2. Select Communities > Manage This Community.

3. Select the Security tab.

4. Click Security Capabilities.

5. Locate the role you want to change and select the check box under each capability to enable 
it or disable it, as shown in Figure 6-8.

Figure 6-8  Edit the Default Capabilities for Each Role

6. Click Save.

7. Click Return to Community.
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Managing the GroupSpace Portlets
This section contains the following topics:

Controlling Who Can View Portlet Data

Changing Default Portlet Preferences

Using GroupSpace QuickLinks

Adding Related Content Items

Viewing the History of Items in a Portlet

Sending Notifications to the Community

Searching Your GroupSpace Community

Enabling GroupSpace Customization

Changing the Appearance of Your GroupSpace Community

Controlling Who Can View Portlet Data
The data in a GroupSpace portlet can be visible just to the user in the Communities to which the 
user belongs, or to all members of the Community.

Use the following definitions help you control who can view a portlet’s data:

Community – All members of the Community can see the data in the portlet. Community 
data is tied to a specific Community.

Personal – The user who created the data belongs to multiple Communities and can see 
the data in all the Communities. Personal data is tied to a user, and personal data is stored 
in a different folder than the Private and Community data.

Private – Only the user who created the data can view the data in this Community. Some 
portlets (Mail, Contacts, Calendar, Tasks, Discussion Forums, and Announcements) cannot 
contain Private data.

A Community member can change the visibility of some private items to be visible to the 
Community. For example, a private Issue can be changed from being visible only to the user that 
created it to being visible to the entire Community. (A saved search can also be changed from 
Private visibility to Community visibility; see “Saving Your Search Queries” on page 7-51.)
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Table 6-1 lists each portlet and who can view the portlet’s data.

Changing Default Portlet Preferences
You can change preferences for some portlets to control the language, time zone, number of items 
to display on each page, default views, and so on.

Perform the following steps to edit a portlet’s preferences:

Table 6-1  Data Visibility Is Controlled by the Community, Personal, and Private Settings

Portlet Name Community Personal Private

GS Issues

Discussion Forums

Mail

Contacts

GS GroupNotes

Calendar

Tasks

GS Links

GS Announcements

GS RSS Reader

GS Document Library

CM Browser



Managing  the  GroupSpace  Por t l e ts

BEA WebLogic Portal GroupSpace Guide 6-17

1. Log into your GroupSpace Community.

2. Select the portlet’s tab and click the portlet’s Edit icon, as shown in Figure 6-9.

Figure 6-9  Edit the Portlet’s Preferences

3. Enter information by clicking General Preferences and Discussion Preferences (this 
example is for the Discussion Forums portlet shown in Figure 6-10; preferences are specific 
to the portlet):

– General Preferences – Choose the preferred time zone.

– Discussion Preferences – Select the number of items to display on each page from the 
Items Per Page drop-down list, as shown in Figure 6-10. Depending on the portlet, 
other preferences can also appear here.
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Figure 6-10  Preferences for the Discussion Forums Portlet

4. Click Save.

5. Click the portlet’s Leave Edit icon.

Using GroupSpace QuickLinks
The GroupSpace Community application contains a an area called QuickLinks to temporarily 
store items. For example, you can create an Issue, copy the Issue to the QuickLinks, and then 
insert the Issue as a Related Item in a GroupNote.

QuickLinks works with the following portlets:

GS Issues

GS GroupNotes

GS Document Library

Perform the following steps to copy and paste an item using QuickLinks:

1. Create an item, such as an Issue, and save it. (See the instructions on “Using the GS Issues 
Portlet” on page 7-2.)

2. Open the item and click Copy to QuickLinks, as shown in Figure 6-11.
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Figure 6-11  Copy the Issue to QuickLinks

You can also click Done (see Figure 6-11) and then drag and drop the title of the item to 
the QuickLinks area at the top of the page. (You can also hover your mouse over the title 
of the item, click the arrow that appears, and choose Copy to QuickLinks.) The 
QuickLinks area can hold up to five items. You can remove an item from QuickLinks by 
clicking the Remove This Item from QuickLinks icon next to the item.

Figure 6-12 shows one item in the QuickLinks.

Figure 6-12  Items Appear in QuickLinks

3. Open the portlet and the item where you want to copy the item.

4. Drag the QuickLink item to the Related Items section and drop it. If the portlet is longer than 
the page, hold the left mouse key and scroll with your mouse scroll wheel. (You can also click 
Add Related Items and select the QuickLinks option. Select a Resource Type to view the 
contents of QuickLinks, choose an item to copy into the Related Items section, and click 
Add.)

5. Click Update in the portlet where you dropped the QuickLinks item. The item now appears 
in the Related Items section, as shown in Figure 6-13.
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Figure 6-13  The QuickLinks Item Appears as a Related Items Icon

Tip: Dragging an item to QuickLinks makes a copy of the item and places it in the QuickLinks 
area. Clicking Move QuickLink Item Here (instead of copying the item), removes the 
item from QuickLinks and places it in the new portlet.

Adding Related Content Items
When you establish a relationship between two resources in a GroupSpace portlet (for example, 
you relate a document to an Issue), you have created a related content item. Related content items 
are relationships to GroupNotes, Issues, Discussions, and Document Library items.

Viewing the History of Items in a Portlet
You can monitor who added or changed items in your GroupSpace application during a specific 
time frame. 

This history is available for the following portlets:

GS Issues

GS GroupNotes

GS Document Library
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GS RSS Reader

Perform the following steps to view the history of items added or modified in a portlet:

1. Select the Review tab.

2. At the Resource Type field, choose a resource type from the drop-down list.

3. At the View Items Modified or Created in the Past x Days field, select a number from the 
drop-down list. The new or modified items appear in the list, as shown in Figure 6-14.

Figure 6-14  New GS Issues Added or Modified in the Last Seven Days

4. Click an item to view its details in the appropriate portlet.

Sending Notifications to the Community
The GroupSpace Notifications Center advises you when Announcements, Invitations, and E-mail 
items appear and when Calendar items and Tasks are due. The Notification Center is visible from 
anywhere in the GroupSpace Community.

The GroupSpace application checks for Notifications every 15 seconds. If you receive more than 
one e-mail Notification regarding an update to an item you are following, the GroupSpace 
application summarizes the number of updates and sends one Notification. If other Notifications 
occur for Announcements, personal Calendar appointments, personal Tasks, or Invitations, you 
will receive one Notification per item. If you subscribe to more than one GroupSpace 
Community, you will receive separate Notifications for each Community.
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Displaying Notifications can be intrusive or passive. A Critical Notification has a high priority, 
so it is intrusive and a pop-up box informs you that a Critical item is waiting for you. The 
Notification alert disappears if you click OK. You must clear the Notification from the 
Notifications Center, or you will be notified each time you log in. A Notification with a lower 
priority is passive, and is queued so you can view it later.

Tip: If you are expecting a new Notification and do not see it in the Notifications Center, click 
Refresh.

For instructions on creating and managing Announcements, see “Using the GS Announcements 
Portlets” on page 7-13.

Configuring the Notifications Center
You can make changes to the Notifications Center to determine what causes Notifications to 
appear in the Notifications Center and how often.

Perform the following steps to set up the Notifications Center:

1. Click the Notification link at the top of the GroupSpace application, as shown in Figure 6-15.

Figure 6-15  Notifications Link

2. In the Notifications Center, click Configure Options, as shown in Figure 6-16.

Figure 6-16  You Can Determine How Often You Will be Notified for Specific Portlets

3. Select the check boxes to enable the following features:

– Enable interim message retrieval between page navigation – Select this check box 
to view Notifications without doing a full page refresh. If you do not select this check 
box, you will still see the Notifications but they do not dynamically update unless you 
use the GroupSpace application and manually refresh the pages that generate the 
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Notifications. Changing this value requires a full page refresh before the new setting 
takes effect. 

Note: The default Notification time for the poller to run is every 15 seconds for 
Announcements, Invitations, E-mail, Calendar, Tasks, and Invitations. 
Administrators can change this default value by editing an XML file; see the 
Communities Guide for instructions.

– Email – Select the Email check box to be notified when you have an e-mail. Use the 
drop-down list to select when the sent Notification will expire.

– Calendar – Select the Calendar check box to be notified when you have a Calendar 
item that is due. Use the drop-down list to select when the sent Notification will expire. 
You can also set a reminder by choosing to be notified before a Calendar event occurs.

– Tasks – Select the Tasks check box to be notified when you have a Task item that is 
due or overdue. Use the drop-down list to select when the sent Notification will expire.

Figure 6-17 shows the configuration choices.

Figure 6-17  Configure the Notifications Center

4. Click Save.

Viewing Notifications
Perform the following steps to view a Notification:

1. Click the Notification link at the top of the GroupSpace application.

../communities/index.html
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2. Select the type of Notification (for example, Announcements).

3. Click the Notification to view more detail about it.

Note: To remove the Notification after you view it in the Notifications Center, select the check 
box and click Clear Selected.

Searching Your GroupSpace Community
All Community members can retrieve information in and outside the GroupSpace application 
using the following three methods:

Search an individual portlet – Use the portlet’s Search tab or its Search bar to search and 
display information contained in that portlet. For example, a contacts Search for john 
retrieves all contacts listed in your address book with a first name of John.

Search this GroupSpace Community – Use the GS Search portlet to search the current 
Community’s resources, such as Issues, Announcements, Document Library, RSS feeds, 
and so on. You can search the Community where you are logged in.

Search outside of the GroupSpace Community – Use the GS Enterprise Search portlet to 
locate information outside the GroupSpace Community. You can search information stored 
on your server’s file system or on a web site. An Enterprise Search does not retrieve 
GroupSpace Community data.

See “Using the Search Portlets” on page 7-46 for more information.

Customizing Your GroupSpace Community
GroupSpace contains a set of Visitor Tools in the Customize menu. You can use these tools to 
change the content and appearance of your GroupSpace Community.

You can perform the following tasks to customize your GroupSpace Community:

Add and remove portlets, pages, and books

Update the layout of portlets, pages, and books

Change the GroupSpace application’s look and feel

Rename a portlet, page, or book

Change the theme of a portlet, page, or portlet

Make changes to the layout and appearance of the Community that affect all users
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This section contains the following topics:

Enabling GroupSpace Customization

Changing the Appearance of Your GroupSpace Community

Enabling GroupSpace Customization
When you create a GroupSpace Community, the default is to be able to customize the new 
Community by adding new pages or portlets, changing the look and feel, adjusting the number of 
columns, and adding content to pages.

Tip: If you cannot see the Customize menu in your GroupSpace application, the Community 
template used to create your GroupSpace Community does not allow you to add pages 
and other customization. You can change this by choosing Communities > Manage 
This Community. In the Properties Page tab, click Edit Location & Access. Select the 
Allow people to customize their view and add personal pages check box and click 
Save. Click Return to Desktop and the Customize menu now appears.

The Customize menu is part of the Visitor Tools that ships with WebLogic Portal. For more 
information on Visitor Tools and how to enable the tools in your application, see the Portal 
Development Guide for more information.

Changing the Appearance of Your GroupSpace Community
You can change the contents on a page and the layout of the page’s columns. 

Changing the Page Layout
Perform the following steps to change the layout of a page in your GroupSpace application:

1. Log into your GroupSpace application.

2. Choose Customize > Page Contents, as shown in Figure 6-18.

../portals/index.html
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Figure 6-18  Choose Page Contents to Change the Layout or Contents of a Page

3. Select the page you want to customize by selecting an item from the drop-down menu and 
clicking Go, as shown in Figure 6-19.

Figure 6-19  Select a Page to Customize

4. The dialog reflects the portlets that you are changing. For example, the Collaborate page 
contains one portlet. Change the layout of the page you are in by clicking Change Layout.

Tip: You can also click the up and down arrows to change the portlet’s position on the page.

5. Select one of the layouts to determine the number of columns and click Change Layout.

6. Click Save Changes. Figure 6-20 shows how the Collaborate page was changed from a single 
column layout to a two-column layout.
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Figure 6-20  The Collaborate Page Now Has a Two-Column Layout

Changing the Content on the Page
Perform the following steps to change the content that displays on a page in your GroupSpace 
application:

1. Choose Customize > Page Contents.

2. Select the page you want to customize by selecting an item from the drop-down menu and 
clicking Go.

3. Click Add Content to display the available portlets. 

4. In the Browse Content tab in the Browse Portlets view, pick a portlet by selecting the check 
box next to it and clicking Save Changes. Figure 6-21 shows how to select the Related Items 
portlet check box and where it appears on the page. 
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Figure 6-21  Adding Content, such as the Related Items Portlet to a Page

Tip: You can change a portlet’s theme, rename the portlet, delete the portlet, or edit the 
portlet’s content (available only in a book) by clicking the portlet’s icons. See 
Figure 6-21. A theme is the Look & Feel of part of the GroupSpace application, such 
as a page or a portlet.

You can also add content with the following steps:

– In the Browse Content tab in the Change Page Contents and Layout dialog, click 
Browse Books to add the contents of an existing GroupSpace tab. For example, if you 
add the Collaborate book, the three Collaborate portlets (GS Issues, Discussion Forums, 
and GS GroupNotes) are added in a tabbed format, as shown in Figure 6-22.

 
 
 Remove

Change Theme

Rename

Edit Contents
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Figure 6-22  Adding the Collaboration Book

If you add each portlet separately, the tabs shown above do not appear.

– Search for a specific portlet by selecting the Search tab in the Change Page Contents 
and Layout dialog, entering a search term, and clicking Search. The search is not case 
sensitive. Search displays a maximum of 200 items. 

– Add remote portlets by selecting the Add Remote Content tab, entering a search term, 
and clicking Search. Select the check box next to the remote portlet and click Save 
Changes. For example, entering organiz might retrieve portlets, such as the Daily 
Organizer, Lotus Organizer, RSS NonProfit Organizations, and so on. This type of 
search queries the Universal Description, Discovery and Integration (UDDI) registry 
for the name and all available metadata of a particular content item, including the 
producer. The UDDI registry contains all available portlets on the server and is used in 
an enterprise to share web services.

Changing the Look & Feel of a Page
A theme lets you override a portal desktop's overall Look & Feel on individual books, pages, and 
portlets.

If you modified the default GroupSpace Look & Feel, or created a new GroupSpace Look & Feel 
from the default GroupSpace Look & Feel, you can apply that change to a book, page, or portlet. 
(You can also change the Look and Feel for the entire GroupSpace Community; see “Changing 
the GroupSpace Look & Feel” on page 4-15.)
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Tip: Only the GroupSpace default (gsdefault) Look & Feel is compatible with GroupSpace; 
you should make all other Look & Feel files (Default, Classic, All Text, and Legacy) 
unavailable to users. The best way to do this is to create an entitlement role to which no 
one belongs, and then entitle the other Look & Feel files so that they are available only 
to that role. Leave the GroupSpace default Look & Feel unentitled so that it is available 
to all users.

Perform the following steps to change the theme (the colors and appearance) for pages, portlets, 
and books:

1. Choose Customize > Colors.

2. Select a new Look & Feel and click Change Colors, as shown in Figure 6-23. (Do not select 
the Bighorn XHTML Look & Feel because GroupSpace is not XHTML compatible.)

Figure 6-23  Select a New Look & Feel

Adding and Creating a New Page
Perform the following steps to change the order of the tabs that appear in your GroupSpace 
application, add existing pages, and create new pages (which appear as tabs):

1. Choose Customize > Pages.
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Tip: If you cannot see the Customize menu, the Community template used to create your 
GroupSpace Community does not allow you to add pages and other customization. 
You can change this by choosing Communities > Manage This Community. In the 
Properties Page tab, click Edit Location & Access. Select the Allow people to 
customize their view and add personal pages check box and click Save. Click 
Return to Desktop and the Customize menu now appears.

2. Select a page from the drop-down menu. This tab will be highlighted when you log in.

3. Change the order of the tabs by clicking the up or down arrow and clicking Save Changes.

4. Add a new page by clicking Add and Create Pages. Select the Select Pages Below field and 
select the check box next to the page you want to add. Click Add Page.

5. Create a new page by clicking Add and Create Pages. Select the Create New Page option 
and enter a Page Name, type an optional Description, and select an optional Layout from 
the drop-down list. For example, create a new tab called Project Status to track specific 
milestones related to your project. Click Create Page. After you create a new page, add it to 
the GroupSpace application by following the instructions in step 4.

6. Click Save Changes and the new tab appears. Figure 6-24 shows the new Project Status tab.
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Figure 6-24  The New Page Appears as a Tab

Changing the Look & Feel for the Community
You can use Admin Mode to make changes to the layout and appearance that all Community 
members will see. (You can also create a new Look & Feel for the GroupSpace Community; see 
“Creating a New GroupSpace Look & Feel” on page 4-17.)

Perform the following steps to change the look and feel for the entire Community:

1. Choose Customize > Switch to Admin Mode.

2. Click OK.

3. In Admin Mode, use the Customize menu to make changes to the layout of the pages, each 
page’s content, look and feel, and so on.

4. When you finish your changes, choose Customize > Return to Normal Mode.

Customizing Template JSPs
GroupSpace Community administrators might add customized properties to the object class, in 
order to customize the portlets. If you want these properties to appear in a different location in 
the portlet, you must modify the template JSP file. For example, if you add a property called 
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Tracking Number to the Issue Type definition, you might want that Tracking Number field to 
appear first in the Issues portlet when you click Details. 

You can customize the templates to change the appearance of the following GroupSpace portlets:

GS Announcements

GS Document Library

GS Issues

GS Links

GS RSS Reader

CM Browser (see the Content Management Guide for more information)

You can customize the portlets in WorkSpace Studio by copying the template JSP files into your 
web application and modifying the template JSPs. Your changes are included in the GroupSpace 
library modules, and the changes are applied automatically and detected by the GroupSpace 
Community portlets. If you customize the look and feel of your portlets, those changes will be 
reflected in your modified GroupSpace portlets. If you apply a WebLogic Portal Service Pack, 
your JSP modifications will be saved.

Tip: Modifications that you make to the template JSP files are not supported by BEA’s 
Customer Centric Engineering group.

Perform the following steps to customize a template JSP:

1. In WorkSpace Studio, create a GroupSpace-enabled portal. See the instructions in the Portal 
Development Guide.

2. In the Merged Projects view, expand your <web project> folder and the templates subfolder. 
(The files in the templates directory are part of the wlp-groupspace-web-lib library module.)

3. Locate the display template file you want to modify. Some files and folders in your web 
project might be italicized, which means that you are using the original copy of the contents 
on the library module. Right-click the display template file in the templates subfolder and 
choose Copy To Project. This action creates a duplicate copy of this file and stores it in your 
web project. Do not rename the file; keep the existing name. After the file is copied to your 
web project, the file’s name is no longer italicized.

4. Open the template JSP file you want to modify by double-clicking the file. For example, 
double-click the displayAnnouncementsTemplate.jsp file in the templates subfolder.

../portals/index.html
../portals/index.html
../cm/index.html
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5. Modify the JSP by moving the properties up or down in the JSP to change the order in which 
the properties appear, or making a property not display by placing it in the Excluded 
Properties list. Modify the following items in the JSP:

– Included properties – The includedProperties section lists the properties in the 
order that they are displayed in the GroupSpace portlet. For example, in the 
displayAnnouncementsTemplate.jsp file, the included properties are Title, 
Description, Effective Date, Expiration Date, Severity, and so on.

– Excluded properties – The excludedProperties section contains the properties that 
do not display in the GroupSpace portlet. For example, in the 
displayAnnouncementsTemplate.jsp file, the excluded properties are Related 
Nodes, Attachments, Community ID, and so on.

– Dynamic properties – If a property is not listed in the included or excluded properties 
sections, the property appears in the dynamic properties section (called other). For 
example, User Time Zone could be a dynamic property and it then appears at the 
bottom of the portlet. The GS Links portlet is the only portlet does not have a separate 
dynamic properties section, so new properties appear at the bottom of the list.

6. Save the file. Your changes are automatically applied.
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C H A P T E R 7

Using the GroupSpace Portlets

This chapter describes how to use the GroupSpace Community portlets. A portlet is a Web-based 
component that processes requests and generates dynamic content. GroupSpace portlets can 
communicate with each other. You can customize the content and appearance of a portlet to meet 
your specific business needs.

GroupSpace contains 13 Community-enabled portlets that work inside the GroupSpace 
Community. The portlets that do not begin with GS (such as Tasks) can be used outside of a 
GroupSpace Community.

Tip: The portlet preferences for the portlets that can be used outside of a GroupSpace 
Community (Tasks, Mail, Calendar, Contacts, and Discussion Forum) are ignored inside 
a GroupSpace Community.

This chapter contains the following sections:

Using the Portlet Icons

Using the GS Issues Portlet

Using the GS Links Portlet

Using the GS RSS Reader Portlet

Using the GS Announcements Portlets

Using the GS Document Library Portlet
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Using the GS GroupNotes Portlet

Using the Tasks Portlet

Using the Discussion Forums Portlet

Using the Mail Portlet

Using the Calendar Portlet

Using the Contacts Portlet

Using the CM Browser Portlet

Using the Search Portlets

Optimizing Portlet Performance

Using the Portlet Icons
Each portlet contains icons that allow you to edit the portlet’s properties, delete it, enlarge it, or 
reduce it, as shown in Figure 7-1.

Figure 7-1  Portlet Icons

Editing the portlet’s preferences lets you change the language, time zone, and other 
portal-specific settings.

Using the GS Issues Portlet
Use the GS Issues portlet to create lists of topics that are related to a project. For example, project 
managers can maintain a list of open issues that are migrated to closed issues as they are resolved. 
Any Community member in a contributor or owner role can create an Issue.

You can create Issues that are Private, Personal, or visible to the Community. See “Controlling 
Who Can View Portlet Data” on page 6-15 to learn more about who can view portlet data.

You can also filter the list of Issues by status (for example, to show all Open Issues).

Maximize Minimize

DeleteEdit
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Tip: Issues are different than Tasks because Issues do not have a due date. Users could create 
a Task based on an Issue, to track the work required to resolve the Issue.

Adding an Issue
Perform the following steps to add a new Issue:

1. Select the Collaborate tab and the Issues tab. 

2. In the Browse tab, select the Community tab to create a Community Issue that all members 
of the Community can view. Select the Personal tab to create a Personal Issue that the user 
can view across all the Communities to which the user belongs. (You can also create a Private 
Issue by creating a Community Issue and marking it as Private. See step 5 for instructions.)

3. You can create an Issue and place it in the top-level Issues folder, or you can put the Issue in 
a subfolder. Select the location in the tree where you want the folder and click Create Folder. 
Enter the name in the Folder Name field and click Create Issue Folder.

4. Select the folder where you want to place the Issue and click Create Issue, as shown in 
Figure 7-2.

Figure 7-2  Create a New Issue to Track Comments and Progress

5. The text fields for an Issue are limited to 256 characters. In the Create New Issue area, enter 
the following information:

– Title – Enter a brief title that describes the Issue. The field is limited to 254 characters.

– Description – Enter more detail about the Issue. The field is limited to 254 characters.
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– Make Private – Select this check box to ensure that only you can view this Issue in 
this GroupSpace Community. If you do not select the Make Private check box, all 
Community members can view the Issue. Community issues are stored in the database 
at \GroupSpace\collaborationApp\collaborationWebApp\community\ 
publicCommunity\Issues hierarchy, while Private Issues are stored in your personal 
folder in the database at \users\<a>\<andrew>\<ProjectStatusIssue> hierarchy. 
In the example, the <a> directory reflects the first letter of the user name and the 
<ProjectStatusIssue> represents the name of the Issue.

– Owner – Enter the Community member you are assigning to the Issue, or click Find 
User to locate the user. In the Member Picker window, you can click Show All 
Members to view all Community members, or select a letter to view member names 
that begin with that letter. Select the radio button next to the member’s name and click 
OK.

– Notes – Enter more information about the Issue, or report progress on resolving the 
Issue. If your System Administrator and Portal Administrator enabled the rich text 
editing formatting toolbar and the bottom toolbar for this portlet, you can use the 
formatting toolbar (see Figure 4-5 in Chapter 4) to format your text. Clicking the 
bottom toolbar’s HTML button lets you view the body with the HTML tags inserted, 
and clicking the Preview button allows you to view the Issue before you save it.

Tip: If you do not see the formatting toolbar or the bottom toolbar, rich text editing and 
the bottom toolbar are not enabled for this portlet. The rich text editing formatting bar 
is enabled by default (but the bottom toolbar is disabled) in the GS Example 
Community that ships with WebLogic Portal. In other web projects, rich text editing 
and the bottom toolbar are disabled by default. For instructions on enabling rich text 
editing, see “Setting Up the Rich Text Editor” on page 4-18.

– Priority – Select the drop-down list and choose High, Medium, or Low. This field is 
internationalized so you can change the displayed language if you want.

– Status – Select the drop-down list and choose Opened, In Progress, or Closed. This 
field is internationalized so you can change the displayed language if you want.

– Resolution – Enter comments after the issue is resolved by editing the Issue and 
completing this field. For example, you could use these Resolution summaries to 
review all Issues with a Closed status.

– Flagged – Select this check box to set the Flagged field to true. Use the Flagged field 
to monitor Issues that are important to you. Select the Search tab in the Issues tab to 
search for issues you have flagged.
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– Related Items – Click Add Related Items to insert a relationship to certain content or 
artifacts, or a QuickLink item to include information that pertains to this issue. The 
Add Related Items window lets you search for content by choosing a QuickLink item 
or entering a search query. You can select a Full Text Search (to search all available 
text) or Field Search (to search specific fields), enter a search query or keyword, and 
click Search. You can also narrow your search by selecting a type of resource from the 
Resource Type drop-down list. When you locate a content item, select the check box 
next to it and click Add. A reference to the document appears in the Related Items 
field.

Figure 7-3 shows the fields to complete to create an Issue.
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Figure 7-3  Create a New Issue

6. Click Create Issue. 

7. Click Done, and the Issue appears in the GS Issues portlet, as shown in Figure 7-4. 
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Figure 7-4  New Issue

Note: An Issue can reside in only one folder You can move (or drag and drop) an Issue to a 
folder in the tree where the Issue was created. For example, you can move a 
Community Issue from one folder to another folder in the Community tree, but you 
cannot move a Community Issue to the Personal tree. Personal data is stored in a 
different folder than the Community data.

8. After you create an Issue, you can create Tasks to do to resolve the Issue. See “Using the Tasks 
Portlet” on page 7-23.

Managing Issues
You can also perform the following tasks with Issues: 

Edit an Issue – Modify the Issue by clicking the Issue’s name in the Title column and 
clicking Edit. Click Update Issue when you are done.

Sort the Issue Columns – Click the column’s heading to re-sort the list.

Delete an Issue – Hover the mouse over the Issue, hover over the arrow that appears, and 
choose Delete Issue. Deleting an Issue removes it from the database.

Copy an Issue to QuickLinks – Hover the mouse over the Issue, hover over the arrow 
that appears, and choose Copy to QuickLinks.

Searching Issues
See “Using the Search Portlets” on page 7-46 for instructions on searching the GS Issues portlet, 
performing a GroupSpace search, and searching outside GroupSpace.

Using the GS Links Portlet
The GS Links portlet helps you create and manage Links to URLs, as well as to content that is 
internal to the Community. For example, you might use the GS Links portlet to manage a 
development project, providing links to schedules, progress reports, and software defects.

Links can be created and edited by Community owners, creators, and contributors.
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You can use categories to organize your links. Each category appears as a tab in the GS Links 
portlet. You can add a Link that is visible only to the Community, just to you in this Community 
(Private), or just by you in all the Communities to which you belong (Personal). 

Creating a New Category
The GroupSpace application contains a default Category called Favorite Links. When you create 
a new category, a new tab appears in the GS Links portlet.

Perform the following steps to create a new category in the GS Links portlet:

1. Select the Access tab and the Sites tab.

2. In the GS Links portlet, click Edit Categories.

3. Click Add New Category.

4. Enter a name for the new category and click OK. The field is limited to 50 characters.

5. Click Done. The new Category (for example, Project Status) appears as a tab, as shown in 
Figure 7-5.

Figure 7-5  Create a New Category

You can rename a category by selecting the category tab, clicking Edit Categories, and clicking 
Rename. Enter the new name and click Update Category Name.

Managing Your Categories
You can re-order the category tabs in the GS Links portlet, and you can also delete categories. 
When you delete a category from the GS Links portlet, all links associated with the category are 
also deleted from the portlet.



Using  the  GS  L inks  Po r t le t

BEA WebLogic Portal GroupSpace Guide 7-9

Perform the following steps to change the tab order in the GS Links portlet:

1. In the GS Links portlet, click Edit Categories.

2. In the Reorder column for the category you want to change, click the up or down arrow to 
change its order.

Note: To delete a category, select the check box next to the category and click Delete 
Selected Categories.

3. Click Done.

Adding a New Link
A Link can reside in only one folder.

Perform the following steps to add a new link:

1. Select the Access tab and the Sites tab.

2. In the GS Links portlet, select a category tab and click Add New Link.

3. Enter the following information.

– Title – Enter text that describes the link. The field is limited to 254 characters.

– Description – Enter more detail about the link. The field is limited to 254 characters.

– URL – Enter the URL you want to use as a link. The field is limited to 254 characters.

– Make Private – Select this check box to be the only user who can view the data in this 
Community.

4. Click Add New Link. The new link appears in the GS Links portlet, as shown in Figure 7-6. 
Clicking a Link opens the link in a browser.
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Figure 7-6  New Link

Adding a GroupSpace Resource
You can add a new GroupSpace Resource, which is a link to another GroupSpace artifact.

Perform the following steps to add a GroupSpace Resource:

1. Select the Access tab and the Sites tab.

2. In the GS Links portlet, select a category tab and click Add GroupSpace Resource.

3. You can insert a relationship to certain content or artifacts, or a QuickLink item. The Add 
Related Items window lets you search for content by choosing a QuickLink item or entering 
a search query. You can select a Full Text Search (to search all available text) or Field Search 
(to search specific fields), enter a search query or keyword, and click Search. You can also 
narrow your search by choosing the type of resource from the Resource Type drop-down list. 
When you locate a content item, select the check box next to it and click Add. The link 
appears in the category tab.

Managing Your Links
You can also perform the following tasks:

Edit a Link – Modify the link by hovering your mouse over the Link, hovering over the 
arrow that appears, and choosing Edit Link. Enter your changes and click Update Link.

Re-order the Links – Re-order how the Links appear by clicking Edit Links. Click the up 
or down arrow to reorder the link and then click Done.

Move a Link – Move a Link to another category by dragging the Link to the category’s 
tab.



Using  the  GS  RSS  Reader  Po r t le t

BEA WebLogic Portal GroupSpace Guide 7-11

Delete a Link – Remove a link from the GS Links portlet by hovering your mouse over 
the Link and choosing Delete Link.

Searching Links
See “Using the Search Portlets” on page 7-46 for instructions on searching the GS Links portlet.

Using the GS RSS Reader Portlet
The GS RSS Reader portlet connects to external sites that provide Rich Site Summary (RSS) or 
Atom information and displays the channels as clickable links. RSS is a format used to syndicate 
news and other web content. RSS channels can include web sites and weblogs. Examples of RSS 
channels include NewsGator, Safari, and newyorktimes.com.

An RSS channel can be plain text, HTML, or XML. You can set up an RSS channel to be visible 
to everyone in the Community, just to you in this Community, or just to you in all the 
Communities to which you belong.

By default, owners, creators, and contributors can add RSS channels; see “Editing Default Role 
Capabilities” on page 6-14 for more information.

The GS RSS Reader portlet stores the URLs, title, header, and author in the Content Management 
System, but not the body of the article. An archive feature stores the body of the article.

WebLogic Portal supports the following versions of RSS and Atom feeds:

RSS 0.90

RSS 0.91 Netscape

RSS 0.91 Userland

RSS 0.92

RSS 0.93

RSS 0.94

RSS 1.0

RSS 2.0

Atom 0.3

Atom 1.0 
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Subscribing to an RSS Channel
Perform the following steps to subscribe to an RSS channel:

1. Select the Access tab and the Sites tab.

2. In the GS RSS Reader portlet’s Browse tab, select the Community tab or the Personal tab. 
Selecting the Community tab allows other Community members to see the new RSS 
information and places the item in the RSS Channels folder. If you select the Personal tab, 
only you can see the new RSS information (in all the Communities to which you belong) and 
the channel is placed in the RSS Feeds folder.

3. Click Create New RSS Channel.

4. Enter the URL to the RSS channel. For example, http://rss.news.yahoo.com/rss/oddlyenough.

5. If you are in the Community tab, you can select the Make Private check box to be the only 
user who can view the data in this Community.

6. Click Create RSS Channel.

7. Click the RSS channel to select it and see its entries, as shown in Figure 7-7. 

Figure 7-7  New RSS Channel

Managing RSS Channels
You can also perform the following tasks in the GS RSS Reader portlet:
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Edit an RSS Channel – You can change an RSS channel from a personal channel to a 
Community channel. Hover your mouse over the channel and when the arrow appears, 
choose Edit Channel. Change the visibility to Community and click Update RSS 
Channel. You cannot change the visibility of a Community-scoped channel.

Delete the RSS Feed – Remove the RSS feed by hovering your mouse over the channel, 
clicking the arrow that appears, and choosing Delete Channel.

View a Channel Entry – Click the channel to view all of its entries. Click a specific entry 
to view a summary of the article. Click Read more to see the full article.

Archive an RSS Channel – Click the channel to view its entries. Hover your mouse over 
a specific feed entry, click the arrow that appears, and choose Toggle Archival for this 
Article or click the file cabinet icon. The Archive icon becomes active. An archived feed is 
saved to the database.

Searching RSS Feeds
You can use the GS Search portlet (in the Search tab) or the GS RSS Reader’s Search tab to 
search RSS channels. Both types of search let you do a Full Text Search or a Field Search. A Full 
Text Search is performed against the channel summaries, rather than the feed itself. A Field 
Search is performed on the properties of individual feed entries (title, visibility, and so on).

See “Using the Search Portlets” on page 7-46 for instructions on searching the GS RSS Reader 
portlet.

Using the GS Announcements Portlets
The GS Announcements portlets displays important notices to the Community. Two GroupSpace 
portlets let you create and view Announcements:

GS Announcements – View Announcements

GS Announcements Manager – Create, edit, and delete an Announcement

An Announcement contains a Title, Description, Body, Effective Date and Expiration Date, 
Severity, and an Address To recipient.

Any Community member with create capabilities can create an Announcement. All Community 
members can view the Announcement (based on the Address To field). An Announcement is sent 
only once. When an Announcement expires, it automatically disappears from the GS 
Announcements portlet and the GS Announcements Manager portlet.
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Creating an Announcement
Perform the following steps to create a new Announcement:

1. Select the Communicate tab and the Announcements tab. 

2. In the GS Announcements Manager portlet, click Create Announcement.

3. In the New Announcement area, enter the following information:

– Title – Enter text that briefly describes the Announcement.

– Description – Enter additional text about the Announcement.

– Severity – Select one of the following items from the drop-down list:

• Normal – The Notification is sent based on the normal timer sequence.

• Critical – One Notification alert is sent per session according to the time you set in 
the Effective Date field. The GroupSpace application checks every five minutes for 
Critical Announcements and it sends the Critical Alert, which appears as a pop-up 
window.

• Low – The Notification is sent based on the normal timer sequence.

– Address To – Choose All or a subset of the Community that will receive the 
Announcement:

– Effective Date – Click the calendar icon to choose the date and time you want to send 
the Announcement. The effective date must be later than the current date.

– Expiration Date – Click the calendar icon to choose the date and time you want the 
Announcement to expire. The Expiration Date must be later than the Effective Date; the 
default is one week later. The Announcement must be effective for at least 
24 hours.

– Body – In the text area, enter the body of the Announcement. If your System 
Administrator and Portal Administrator enabled the rich text editing formatting toolbar 
and the bottom toolbar for this portlet, you can use the formatting toolbar (see 
Figure 4-5 in Chapter 4) to format your text. Clicking the bottom toolbar’s HTML 
button lets you view the body with the HTML tags inserted, and clicking the Preview 
button allows you to view the Announcement before you save it.

Tip: If you do not see the formatting toolbar or the bottom toolbar, rich text editing and 
the bottom toolbar are not enabled for this portlet. The rich text editing formatting bar 
is enabled by default (but the bottom toolbar is disabled) in the GS Example 
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Community that ships with WebLogic Portal. In other web projects, rich text editing 
and the bottom toolbar are disabled by default. For instructions on enabling rich text 
editing, see “Setting Up the Rich Text Editor” on page 4-18.

Figure 7-8 shows a new Announcement.
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Figure 7-8  New Announcement

4. Click Add. Based on the Address To field, some or all Community members receive a 
Notification when the Announcement is created. A Notification also appears in your 
Notifications Center.
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Managing Announcements
Owners and contributors can also perform the following tasks in the GS Announcements 
Manager portlet:

Edit an Announcement – Modify the Announcement by clicking it and clicking Edit. You 
cannot modify an Announcement that has already been sent.

Delete an Announcement – Remove the Announcement that you created by selecting the 
check box next to it and clicking Delete. Deleting an Announcement removes it from the 
database. If you do not manually delete an Announcement, it is deleted after it expires.

Editing or deleting an Announcement affects its status in the Notifications Center. 

Viewing Announcements
All users can view the GS Announcements portlet.

You can perform the following actions in the GS Announcements portlet:

View more details about the Announcement by clicking its title in the GS Announcements 
portlet.

Click the Notifications Center link to view the Announcement, as shown in Figure 7-9.

Figure 7-9  Notifications Center

After you click Announcements(1) (see Figure 7-9), you can remove the notification for 
the Announcement by selecting the Delete check box and clicking Delete Selected.

The Announcement disappears from the GroupSpace application when it expires.
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Using the GS Document Library Portlet
The GS Document Library portlet provides access to a collection of documents and other content 
for GroupSpace Community members. This document library lets you create, group, and share 
documents with other Community members. The GS Document Library portlet lets you place 
items in folders and subfolders. Content is saved to the BEA Virtual Content Repository.

GroupSpace creators, owners, and contributors can create documents and content items. The GS 
Document Library portlet also allows users to browse the directory where they have access 
privileges. If the user belongs to more than one Community, all personal content that the user is 
allowed to see is displayed.

Documents can be any type of file; for example, MS Word files, text files, or binary files.

Tip: You might want to create a folder before you create a document; so that you can place 
the document directly in the folder. Click Create Folder, enter a name, and click Create 
Document Folder. You can create folders for Community documents, but not for 
Personal documents.

Perform the following steps to add a new document or file to the GS Document Library:

1. Select the Access tab and the Content tab.

2. In the Browse tab of the GS Document Library portlet, select the Community tab to add a 
document that is visible to all Community members. In the Community tab, you can choose 
to make the document Private (visible only to you in this Community). You can select the 
Personal tab to add a document that is visible to you in all the Communities to which you 
belong.

3. Select the folder where you want to place the document and click Create Document. (You 
cannot create folders for Personal documents.)

4. Enter the following information:

– Title – Enter a unique name for this document. 

– Description – Enter text that describes the document.

– Make Private – Select the check box to make this document visible only to you in this 
Community. If you do not select the check box, the document is visible to all 
Community members.

– Author – Enter the Community member who created this document.
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– Keywords – Enter searchable words that are contained in this document. This field 
allows you to quickly retrieve the document when you perform a property search.

– File – Attach a file. Click Browse, locate the file, and click Open. The file can be any 
type of file, including an MS Word file, text file, or a binary file.

– Related Items – Click Add Related Items insert a relationship to certain content or 
artifacts, or a QuickLink item to include information that pertains to this document. The 
Add Related Items window lets you search for content by choosing a QuickLink item 
or entering a search query. You can select a Full TextSearch (to search content or 
metadata) or Field Search (to search specific fields), enter a search query or keyword, 
and click Search. You can also narrow your search by selecting a type of resource from 
the Resource Type drop-down list. When you locate a content item, select the check 
box next to it and click Add. A reference to the document appears in the Related 
Items field.

Review Figure 7-10 to see all the fields.

Figure 7-10  New Document

5. Click Create Document. The new document appears in the GS Document Library portlet.

Managing Documents
Creators, owners, and contributors can perform the following tasks in the GS Document Library 
portlet (except where indicated):
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Download a Document – Viewers (as well as creators, owners, and contributors) can 
retrieve a copy of the file by clicking the document’s title and then clicking Download. 
Choose Open or Save.

Edit a Document – Modify the document or the attached file by clicking the document’s 
title and then clicking Edit. Enter your changes and click Done.

Delete a Document – Remove the document by hovering your mouse over it, clicking the 
arrow that appears, and choosing Delete Document. Deleting a document removes it from 
the database. By default, a contributor cannot delete a document.

Copy a Document to QuickLinks – Copy a document to the QuickLinks area by hovering 
your mouse over it, clicking the arrow that appears, and choosing Copy to QuickLinks. 

Edit a Community Folder – Rename a folder by selecting it and clicking Edit.

Create a Community Subfolder – Select the parent folder, hover your mouse over it, 
click the arrow that appears, and choose Create New Subfolder.

Searching Documents
See “Using the Search Portlets” on page 7-46 for instructions on searching the GS Document 
Library portlet.

Using the GS GroupNotes Portlet
Owners and Contributors can use the GS GroupNotes portlet to create and update formatted 
documents to share with the Community. Standard formatting includes bullets, italics, bold, or 
colored text, and so on. You can also insert links or references to web sites, other GroupNotes 
documents, and GroupSpace content items (such as Issues).

Tip: You might want to create a folder before you create a document, so that you can place 
the document directly in the folder. Click Create Folder, enter a name, and click Create 
Folder.

Creating a GroupNote
Perform the following steps to create a new document:

1. Select the Collaborate tab and the GroupNotes tab.
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2. In the GS GroupNotes portlet, expand the tree and select the folder where you want to place 
the document. 

3. Click Create GroupNote to start a new document.

4. In the Title field, enter a name for this document.

5. In the Description field, enter text that describes your document.

6. Select the Make Private check box to make this document viewable only by you in this 
Community. If you do not select the Make Private check box, the document is available to 
the entire Community, or to all Communities to which you belong. Personal documents are 
stored in a separate folder from Community and Private information.

7. In the Body area, type information about the GroupNote. If your System Administrator and 
Portal Administrator enabled the rich text editing formatting toolbar and the bottom toolbar 
for this portlet, you can use the formatting toolbar (see Figure 4-5 in Chapter 4) to format your 
text. Clicking the bottom toolbar’s HTML button lets you view the body with the HTML tags 
inserted, and clicking the Preview button allows you to view the GroupNote before you save 
it.

Tip: If you do not see the formatting toolbar or the bottom toolbar, rich text editing and 
the bottom toolbar are not enabled for this portlet. The rich text editing formatting bar 
is enabled by default (but the bottom toolbar is disabled) in the GS Example 
Community that ships with WebLogic Portal. In other web projects, rich text editing 
and the bottom toolbar are disabled by default. For instructions on enabling rich text 
editing, see “Setting Up the Rich Text Editor” on page 4-18.

8. In the Body, you can insert the following kinds of links in a GroupNotes document:

– Web Site – Choose Insert > Link to insert a link to a web site by adding the URL to a 
fully qualified URL. The fields in the Link Properties window correspond to standard 
HTML attributes for an anchor tag. Click OK. 

– GroupNote Rich Text Document – Choose Insert > Link to GroupNote to insert a 
link to another rich text object. Use the portlet search tool to locate the document you 
want to insert in this GroupNote.

– GroupSpace Content item – Choose Insert > Link to GS Resource to insert a link to 
a content item, such as an Issue, contained in the virtual content repository. Use the 
portlet search tool to locate the content you want to insert in this GroupNote.
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9. Click Add Related Items to insert a relationship to certain content or artifacts, or a 
QuickLink item to include information that pertains to this GroupNote. The Add Related 
Items window lets you search for content by choosing a QuickLink item or entering a search 
query. You can select a Full Text Search (to search content or metadata) or Field Search (to 
search content properties), enter a search query or keyword, and click Search. You can also 
narrow your search by selecting a type of resource from the Resource Type drop-down list. 
When you locate a content item, select the check box next to it and click OK. A reference to 
the document appears in the Related Items field.

Figure 7-11 shows a GroupNote document.

Figure 7-11  Creating a New GroupNote

10. Click Create GroupNote. The document appears in the GS GroupNotes portlet.

11. Click Done.
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Managing GroupNotes
Owners, creators, and contributors can also perform the following tasks in the GS GroupNotes 
portlet:

Edit a GroupNote Document – Modify the GroupNote document by hovering your 
mouse over the title of the GroupNote. Click the arrow that appears and choose Edit 
GroupNote.

Change the Display Mode – Modify what displays by opening an existing GroupNote and 
clicking Display Mode. Select Normal Mode to display GroupNote folders and perform 
administrative tasks. Select Display Mode with Selected GroupNote to display only the 
content of this GroupNote.

Delete a GroupNote Document – Remove the GroupNote document by hovering your 
mouse over the GroupNote. Click the arrow that appears and choose Delete GroupNote. 
Deleting a GroupNote removes it from the database. A contributor cannot delete a 
GroupNote.

Rename a folder – Select the GroupNotes folder and click Edit. Enter a new folder name 
and click Update Folder.

Searching GroupNotes
See “Using the Search Portlets” on page 7-46 for instructions on searching the GS GroupNotes 
portlet.

Using the Tasks Portlet
The Tasks portlet allows you to create and track Community items or personal items on a To Do 
list. You can view recent tasks and quickly add new tasks. The Tasks portlet can store personal 
information and Community information.

The Tasks portlet provides summary information about a list of tasks including priority, 
attachments, subject, status, and due date. Tasks can be sorted by each of these fields, except file 
attachments and priority.

Adding a Task
Perform the following steps to create a new Task:

1. Select the Schedule tab and the Tasks tab.
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2. Select the Community tab to add a Community task or the Personal tab to add a personal 
task.

3. Click Add Task 

4. Enter the following information:

– Primary Information – Click Primary Information and enter the following 
information:

• Subject – Enter text describing the Task.

• Due Date – Click the calendar icon and select a due date and time.

• Start Date – Click the calendar icon and select a start date and time.

• Status – Click the drop-down list and choose Not Started, Completed, or In 
Progress.

• Importance – Click the drop-down list and choose High, Low, or Medium. On the 
Tasks portlet, high priority tasks are denoted with a red exclamation point, while low 
priority tasks have a blue down arrow.

– Other Information – Click Other Information to add categories for this Task 
(separated by a semicolon), adjust the Percent Complete, or add detailed Comments. 
If your System Administrator and Portal Administrator enabled rich text editing for this 
portlet, you can click Rich text to use the formatting toolbar to format your text, or 
click Plain text to enter text without formatting. If rich text editing is disabled for this 
portlet, the Rich text and Plain text links are not available.

Tip: Rich text editing is enabled by default in the GS Example Community that ships with 
WebLogic Portal, but not in other web projects. For instructions on enabling rich text 
editing in a portlet, see “Setting Up the Rich Text Editor” on page 4-18.

– Attachments – Click Attachments to add a document to this Task. Click Browse to 
locate the document and click Attach. The Task is saved before you add the 
attachment.

See Figure 7-12.



Using  the  Tasks  Po r t l e t

BEA WebLogic Portal GroupSpace Guide 7-25

Figure 7-12  New Task with an Attachment

5. Click Save. This Task appears in the Tasks portlet with a red exclamation point to show it has 
a high priority, as shown in Figure 7-13.

Figure 7-13  High Priority Task

You can view information differently by clicking the columns to reorder them.

Managing Tasks
View Detail About a Task – See more information about the Task by clicking the Task 
name in the Subject column.
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Edit a Task – Modify the Task’s details by clicking the Task name in the Subject column 
and clicking Edit.

Mark a Task as Completed on Your To Do List – If the task is completed, you can cross 
it off your list. Select the check box next to the Task and click Mark Complete. The Task 
now has a line through it. The line remains even if you refresh the page.

Find Tasks – Enter the subject of the Task in the Search bar and click Search.

Delete a Task – Remove a Task from your To Do list by selecting the check box next to 
the Task and clicking Delete. Click OK.

View Notifications for Tasks – View a notification when a Task is due or overdue by 
clicking the Notification link at the top of the GroupSpace application. In the Notifications 
Center, click Tasks, select the Delete check box for the task, and click Delete Selected. To 
set when the notification will expire, see “Configuring the Notifications Center” on 
page 6-22.

Using the Discussion Forums Portlet
The Discussion Forums portlet lets users post and monitor topics of interest. A Community owner 
or creator creates categories (folders) and Discussion Forums, and other Community members 
can post topics and reply to the threaded discussions. Community owners and creators can create, 
edit, and delete categories, Discussion Forums, and topics. Community owners, creators, and 
contributors have create and edit capabilities, and viewers have read capability only.

A Discussion Forum exists within the Community, rather than outside the Community (such as 
an RSS channel).

You can organize your Discussion Forums by creating categories to organize Forums with similar 
topics.

Adding a Category and a Discussion Forum
Perform the following steps to create a category and a Discussion Forum:

1. Select the Collaborate tab and the Discussion Forums tab.

2. You can create a category to organize Discussion Forums with similar topics. Click Add 
Category.

3. Enter the following information for the new category:

– Name – Enter text describing the category that will contain the Discussion Forums.
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– Keywords – Enter searchable words that are contained in this Discussion Forum. Use a 
comma or a space to separate keywords; the or search connector is assumed when the 
search is performed. For example, car, truck retrieves car or truck. This field allows 
you to quickly retrieve relevant Discussion Forums when you perform a property 
search. 

– Description – Enter text describing the category. If your System Administrator and 
Portal Administrator enabled rich text editing for this portlet, you can click Rich text to 
use the formatting toolbar to format your text, or click Plain text to enter text without 
formatting. If rich text editing is disabled for this portlet, the Rich text and Plain text 
links are not available.

Tip: Rich text editing is enabled by default in the GS Example Community that ships with 
WebLogic Portal, but not in other web projects. For instructions on enabling rich text 
editing in a portlet, see “Setting Up the Rich Text Editor” on page 4-18.

See Figure 7-14.

Figure 7-14  New Category
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4. Click Add. The category appears in the portlet.

5. Create a Discussion Forum by selecting the category and clicking Add Forum.

6. Enter the following information for the new Discussion Forum:

– Name – Enter text describing the purpose of the Discussion Forum.

– Keywords – Enter searchable words that are contained in this discussion. Use a comma 
or a space to separate keywords; the or search connector is assumed when the search is 
performed. For example, car, truck retrieves car or truck. This field allows you to 
quickly retrieve the Discussion Forum when you perform a property search.

– Author Masked – Select this check box to not display the author.

– Description – Enter text describing the Discussion Forum topic. If your System 
Administrator and Portal Administrator enabled rich text editing for this portlet, you 
can click Rich text to use the formatting toolbar to format your text, or click Plain text 
to enter text without formatting. If rich text editing is disabled for this portlet, the Rich 
text and Plain text links are not available.

Tip: Rich text editing is enabled by default in the GS Example Community that ships with 
WebLogic Portal, but not in other web projects. For instructions on enabling rich text 
editing in a portlet, see “Setting Up the Rich Text Editor” on page 4-18.

7. Click Add. The new Discussion Forum appears in the portlet, as shown in Figure 7-15.

Figure 7-15  New Discussion Forum

Adding a Discussion Topic
After you create a Discussion Forum, Community members can add topics to it.

Perform the following steps to add a topic to a Discussion Forum:
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1. Select the Collaborate tab and the Discussion Forums tab.

2. Select the category and click the name of the Discussion Forum in the Forum column.

3. Click Post New Topic.

4. Enter the following information:

– Name – Enter text describing this topic. The topic name must be unique, and the 
following characters are not permitted: \ and /.

– Keywords – Enter searchable words that are contained in this topic. Use a comma or a 
space to separate keywords; the or search connector is assumed when the search is 
performed. For example, car, truck retrieves car or truck. This field allows you to 
quickly retrieve topics when you perform a property search.

– Author Masked – Select this check box to not display the author.

– Description – Enter text for your topic. If your System Administrator and Portal 
Administrator enabled rich text editing for this portlet, you can click Rich text to use 
the formatting toolbar to format your text, or click Plain text to enter text without 
formatting. If rich text editing is disabled for this portlet, the Rich text and Plain text 
links are not available.

Tip: Rich text editing is enabled by default in the GS Example Community that ships with 
WebLogic Portal, but not in other web projects. For instructions on enabling rich text 
editing in a portlet, see “Setting Up the Rich Text Editor” on page 4-18.

– Attachments – Add a file by clicking Attachments and clicking Browse. Locate your 
file and click Open. Add the file by clicking Attach.

5. Click Save. The Discussion Topic appears in the Discussion Forums portlet. See Figure 7-16.
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Figure 7-16  The New Discussion Topic Appears in the Discussion Forums Portlet

Replying to a Discussion Topic
After you create topics, Community members can post replies to topics.

Perform the following steps to add a topic to a Discussion Forum:

1. Select the Collaborate tab and the Discussion Forums tab.

2. In the Browse tab, select the category and the Discussion Forum.

3. Click the name of the Discussion Forum in the Forum column.

4. Click the topic’s name in the Topic column and click Reply.

5. Enter your reply information and click Save.

Managing Discussion Forums
GroupSpace owners, creators, and contributors can also perform the following tasks in the 
Discussion Forums portlet:

Edit a Discussion Forum – Select the Discussion Forum’s category, click the Forum’s 
name in the Category column, and click Edit.

Edit a Category – Click the category’s name in the Category column and then click Edit.

Delete a Discussion Forum – Click the Discussion Forum’s name and click Delete. 
Deleting a Discussion Forum removes it and all its topics from the database.

In addition to adding a topic to a Discussion Forum, Community members can also perform the 
following tasks:



Using  the  Mai l  Po r t l e t

BEA WebLogic Portal GroupSpace Guide 7-31

Edit Your Topic – Select the category and select the Discussion Forum. Click the topic’s 
name in the Topic column and click Edit.

Control What You See – Select the Discussion Forum and the topic, and click Discussion 
Overview to view the topics and replies in the Discussion Forum. Select Small, Medium, 
or Large for the amount of space available to display topics and replies. You can also 
select the Hide Previews check box.

View More Details – Click Discussion Details to view the author of the topic, date and 
time the topic was posted, and the body of the topic.

Using the Mail Portlet
The Mail portlet allows users to send and receive personal e-mail to other members in your 
GroupSpace Community and to people outside the Community. 

Unread messages are highlighted and display a closed envelope icon. Messages in the Inbox that 
you have already read are not in bold text and the icon is not highlighted.

Configuring the Mail Portlet
You must configure your mail account and add information about your incoming and outgoing 
mail server.

Perform the following steps to configure your mail account for incoming and outgoing mail:

1. Select the Communicate tab and the Mail tab.

2. If the Add Account page does not display, click the Mail portlet’s Edit button.

3. Enter information by clicking Account Information, General Mail Settings, Incoming 
Mail Settings, and Outgoing Mail Settings:

– Account Information – Enter the name of your mail account. Do not use special 
characters. Select the Set as the default account to make this your default mail 
account.

– General Mail Settings – In the Mail message ‘display from’ field, enter the name you 
want to appear in the From field in your e-mails. In the From email address field, 
enter your e-mail address.

– Incoming Mail Messages – Complete all of the fields to set up your incoming mail 
server. Each field is required:

• The incoming mail username – The username to access your incoming mail server.
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• The incoming mail password – The password to access your incoming mail server.

• Incoming mail host name or IP address – The server name or IP address of the 
incoming mail server.

• Incoming mail protocol – The protocol the incoming mail server supports. You can 
select POP3 or IMAP.

• Incoming mail port – The port to connect to the incoming mail server. This defaults 
to the value for the selected protocol. Enter port 110 for POP3 or 143 for IMAP.

• The mail timer retrieve mail interval – The time out value in seconds for the 
incoming mail server to poll for new messages.

– Outgoing Mail Messages – Complete all of the fields to set up your outgoing mail 
server. Each field is required:

• Outgoing mail username – The username to access your outgoing mail server.

• Outgoing mail password – The password to access your outgoing mail server.

• Outgoing mail host name or IP address – The outgoing host name or IP address.

• Outgoing mail protocol – The protocol the outgoing mail server supports. You can 
select SMTP.

• Outgoing mail port – The port to connect to the outgoing mail server. This defaults 
to the value for the selected protocol. For SMTP, enter 25.

See Figure 7-17.
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Figure 7-17  Configuring the Mail Servers

4. Click Save.
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Removing a Mail Account 
If you entered and saved incorrect information when configuring the Mail portlet, an error 
appears. You should delete this incorrect setup information by removing the mail account you 
created.

Perform the following steps to delete the account from the list of mail accounts:

1. In the Mail portlet, click Edit (as shown in Figure 7-18) to get to the Mail Preferences 
window.

Figure 7-18  Click the Edit Icon to View the Mail Preferences Window

2. Click Mail Accounts to expand that section. 

3. Select the account you want to delete.

4. Click Delete to remove the highlighted account. 

Sending E-Mail
Perform the following steps to send an e-mail:

1. Select the Communicate tab and the Mail tab.

2. Click New Message to send a new e-mail.

3. Enter information by clicking Primary Information, Attachments, or Options:

4. Primary Information – Click Primary Information and enter the recipients, subject, and 
additional text. The To field is the only required field. You can also click To to pick a recipient 
from your list of personal contacts. You can click Check Names to view your contacts. In the 
text area, enter text for the body of the e-mail. If your System Administrator and Portal 
Administrator enabled rich text editing for this portlet, you can click Rich text to use the 
formatting toolbar to format your text, or click Plain text to enter text without formatting. If 
rich text editing is disabled for this portlet, the Rich text and Plain text links are not available.

Tip: Rich text editing is enabled by default in the GS Example Community that ships with 
WebLogic Portal, but not in other web projects. For instructions on enabling rich text 
editing in a portlet, see “Setting Up the Rich Text Editor” on page 4-18.
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– Attachments – Click Attachments to add a file to the e-mail. Click Browse, select the 
file, click Open, and click Attach. The file can be a document or a binary file.

– Options – Click Options and select a priority for your e-mail. You can also save a 
copy of the e-mail to your Sent folder and be notified when the recipient reads the mail.

See Figure 7-19.

Figure 7-19  New E-Mail Message

5. Click Send. (Clicking Save as Draft saves the e-mail in your Drafts folder so you can send 
it later.) You cannot delete your Inbox, Sent Items, or Drafts folders.
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Viewing Mail
Perform the following steps to send and view your e-mail and attachments:

1. View an e-mail by clicking the item.

2. You can click Reply to send a reply to the e-mail, or Forward to send the e-mail to someone 
else.

3. If the e-mail has an attachment, click it and click the attachment name, and Open to view it 
or Save to download it.

4. Click Done to return to your other mail messages.

Tip: Click Check Messages to refresh the page and display new e-mails.

Managing Mail
You can also perform the following tasks in the Mail portlet:

Change an E-Mail’s Status – Select the check box next to the e-mail, select Mark as 
Unread or Mark as Read from the drop-down list, and click the arrow next to the 
Message Actions field. For example, if you selected Mark as Unread, the e-mail changes 
from bold text to normal text and the envelope icon is no longer green.

Filter Your E-Mails – Click Unread or High Priority to view messages with that status. 
Click All to view all e-mails in your Inbox.

Create, Rename, Move, and Delete Folders – Manage your mail folders by clicking 
Manage Folders. Create a new folder by selecting where you want the folder, clicking the 
Create Subfolder link, entering a name, and clicking OK. You can also click Rename, 
Delete, Move, or Copy to make changes to folders you created.

Change E-Mail Accounts – Select a different account name from the Accounts 
drop-down list on the Mail portlet.

Delete an E-Mail – Remove an e-mail by selecting the check box next to it and clicking 
Delete. The deleted e-mail is placed in a Deleted folder. When you delete items from that 
folder, the e-mail and any attachments are removed from the database.

Create an E-Mail Signature – Enter text that you can attach to the bottom of outgoing 
messages by clicking the portlet’s Edit icon and clicking Mail Preferences. Enter the 
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information in the Signature field and select the Add signature to outgoing messages 
check box and click Save. Click the Leave Edit icon to return to return to the Mail portlet.

Change the Number of E-Mails Displayed – Control how many e-mails display in the 
Mail portlet by clicking the portlet’s Edit button and clicking Mail Preferences. Select 10, 
25, or 50 from the Messages Per Page drop-down list and click Save. Click Leave Edit to 
return to the Mail portlet.

View Notifications for E-Mail – View a notification when an e-mail item is delivered by 
clicking the Notification link at the top of the GroupSpace application. In the Notifications 
Center, click Email, select the Delete check box for the item, and click Delete Selected. 
To set when the e-mail notification will expire, see “Configuring the Notifications Center” 
on page 6-22.

Searching Mail
You can search for individual Mail folders and messages for keywords that appear in the Subject, 
Body, From, or Date fields.

See the “Using the Search Portlets” on page 7-46 for more information on searching the Mail 
portlet, the GroupSpace Community, and the enterprise. 

Using the Calendar Portlet
The Calendar portlet lets you create and schedule appointments. The Calendar portlet can store 
personal Calendar information and Community Calendar information. 

You can customize the number of Calendar days that display. A Calendar appointment shows up 
in the Notifications Center when the appointment time is within the amount of time you specify.

Adding a Calendar Appointment
Perform the following steps to add an appointment to your calendar: 

1. Select the Schedule tab and the Calendar tab. 

2. Select the Community tab or the Personal tab to add an item to each of those Calendars.

3. Click Add Appointment. You can also click the appropriate time in the calendar and add the 
appointment.

4. Enter the following information about the appointment:
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– Primary Information – Click Primary Information and enter the subject, time, date, 
description, and location of your appointment. You can indicate whether the calendar 
shows your appointment time as busy or free. You can also indicate the importance of 
the appointment: High, Medium, or Low. These settings are reflected on the calendar. 

– In the Description field, enter text describing the appointment. If your System 
Administrator and Portal Administrator enabled rich text editing for this portlet, you 
can click Rich text to use the formatting toolbar to format your text, or click Plain text 
to enter text without formatting. If rich text editing is disabled for this portlet, the Rich 
text and Plain text links are not available.

Tip: Rich text editing is enabled by default in the GS Example Community that ships with 
WebLogic Portal, but not in other web projects. For instructions on enabling rich text 
editing in a portlet, see “Setting Up the Rich Text Editor” on page 4-18.

– Repeating – Click Repeating and indicate the frequency of the appointment. For 
example, if you select Weekly, the appointment is scheduled automatically for the same 
day and time each week. By default, meetings do not repeat. You can also specify an 
end date for repeating meetings. Figure 7-20 shows a recurring meeting every Monday 
for five months.

Figure 7-20  Repeating Calendar Appointment

– Attachments – Click Attachments and add a file to the appointment by clicking 
Browse, choosing a file on your file system, and clicking Attach. 

See Figure 7-21 to view information for a new appointment.
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Figure 7-21  New Calendar Appointment

5. Click Save. The new appointment appears in the Calendar portlet.

Managing Your Calendar
You can also perform the following tasks:

Edit an Appointment – You can reschedule or change an appointment’s time, date, or 
location by selecting the appointment and clicking Edit.



Using  the  GroupSpace  Po r t l e ts

7-40 BEA WebLogic Portal GroupSpace Guide

Changing the View – Modify what you see in the portlet by clicking Day, Week, Month, 
or Upcoming. All day appointments are shown at the top of the calendar page and 
indicated with a yellow bullet point to clearly distinguish them from timed appointments. 
Set the default view by clicking the Calendar portlet’s Edit icon. 

Editing Preferences – Click the Calendar portlet’s Edit icon to specify the following 
preferences:

– Time Zone – Select the time zone in which you are working. 

– Default View – Select Day, Week, or Month to change the scope of your displayed 
calendar. Select Upcoming Events to display the upcoming events view by default. 

– Number of days in Upcoming Events – Select the number of days to display for the 
Upcoming Events view. 

– Time Intervals – Select the interval of time you want your calendar to display by 
selecting one of the pre-set intervals for Day, Week, or Month views. 

– Week Starting Day – Select the day your typical work week begins. 

– Working Hours – Select starting and ending hours for your typical work day.

Deleting an Appointment – Select the appointment and click Delete.

View Notifications for Calendar Items– View a notification when a Calendar item is due 
by clicking the Notification link at the top of the GroupSpace application. In the 
Notifications Center, click Calendar, select the Delete check box for the item, and click 
Delete Selected. To set when the notification will expire, see “Configuring the 
Notifications Center” on page 6-22.

Using the Contacts Portlet
Use the Contacts portlet to view and manage names, addresses, phone numbers, e-mail addresses, 
and other information in a personal address book. The Contacts portlet can store Personal 
Contacts and Community Contacts.

The Contacts portlet works with the Mail portlet. If you receive an e-mail from someone, you can 
open the e-mail in the Mail portlet and click Add to Contacts to add the sender to your Contacts 
list.

Adding a Contact
Perform the following steps to add a new Contact:
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1. Select the Communicate tab and the Contacts tab. 

2. Select the Community tab to add a Community contact or the Personal tab to add a personal 
contact.

3. Click Add Contact. The Add Contact dialog appears.

4. Enter information about the contact by clicking each of the following:

– Primary Information – Enter the contact’s name, including first, middle, and last 
name, as well as title and name suffix. You can also enter the contact’s e-mail address.

– Business Information – Enter the contact’s business details in the Business 
Information section. This section is optional.

– Personal Information – Enter the contact’s personal information, such as home phone, 
personal cell phone, birthday, and so on. This section is optional.

– Other Information – Enter information about the contact. This section is optional.If 
your System Administrator and Portal Administrator enabled rich text editing for this 
portlet, you can click Rich text to use the formatting toolbar to format your text, or 
click Plain text to enter text without formatting. If rich text editing is disabled for this 
portlet, the Rich text and Plain text links are not available.

Tip: Rich text editing is enabled by default in the GS Example Community that ships with 
WebLogic Portal, but not in other web projects. For instructions on enabling rich text 
editing in a portlet, see “Setting Up the Rich Text Editor” on page 4-18.

See Figure 7-22 to view the fields for a new business contact.
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Figure 7-22  Adding a New Business Contact

5. Click Save. The contact appears in the Contacts portlet, as shown in Figure 7-23.
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Figure 7-23  New Contact

Filtering and Navigating Contacts
The Contacts portlet provides several ways to filter and navigate through your list of contacts. If 
the list of contacts is long, the GroupSpace application breaks it into pages. Navigate these pages 
using the arrow buttons. 

To change the default number of contacts per page, click the portlet’s Edit icon. Click 
Addressbook Preferences and use the Contacts per Page drop-down list to change the default 
number of contacts that appear. 

The Contacts portlet lets you filter the contacts that are displayed in the table in several ways, 
including the following: 

View All – Click All to list all contacts in the portlet, as shown in Figure 7-24. 

Figure 7-24  Viewing All Contacts

Alphabetical – Click a letter link to list the contacts whose last names start with that letter. 

Sort Contacts – You can sort the list of contacts by clicking the title of a column. For 
instance, to sort your contacts by last name in ascending order, click the heading of the 
Last column. The up arrow indicates that the column is sorted in ascending order. A down 
arrow indicates descending order. 

Search for Contacts – You can search for contacts by entering a search term and clicking 
Search. For more information on searching contacts, see Searching Contacts.
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Managing Contacts
You can also perform the following tasks:

Editing a Contact – Modify a contact’s information by clicking the contact’s name, 
clicking Edit, and modifying the information. 

Deleting a Contact – Remove one or more contacts by selecting the check box next to the 
contact and clicking Delete. To select all check boxes in a column, click the check box in 
the table’s heading row.

Searching Contacts
You can use the following information to search for contacts:

First name

Middle name

Last name

Company name

E-mail address

To perform a search, enter the search string in the Search field and click Search. The results 
appear in the portlet.

See the “Using the Search Portlets” on page 7-46 for more information on searching the Contacts 
portlet, the GroupSpace Community, and outside the GroupSpace Community.

Using the CM Browser Portlet
Use the CM Browser portlet to read content in BEA content repositories and non-BEA content 
repositories. The Shared Content Repository is the default content repository for a GroupSpace 
application that is created when you create a new GroupSpace domain. If you used the Domain 
Configuration Wizard to create a domain, and you selected the WebLogic Portal GroupSpace 
Application check box, the Shared Content Repository is installed automatically. You can 
browse this repository in your GroupSpace Community; to edit the content, use the WebLogic 
Portal Administration Console.
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If you create a new enterprise application in WorkSpace Studio and select the GroupSpace facets, 
the BEA Repository is added to it (rather than the Shared Content Repository).

You can browse this repository in your GroupSpace Community. You can set Visitor 
Entitlements on a repository or its sub folders; see the Security Guide for more instructions on 
setting up Visitor Entitlements.

Browsing Content
Perform the following steps to read content in the repository:

1. Select the Access tab and the Content tab. 

2. In the Browse tab of the CM Browser portlet, select the repository with the documents you 
want to read. If a subfolder exists, click the subfolder to view its documents. The GS Example 
Community uses the Shared Content Repository. The Shared Content Repository is the 
default content repository for a GroupSpace application that is created when you create a new 
GroupSpace domain.

3. View a document by clicking the document name.

Managing Content
You can also perform the following tasks:

View Details – Click Show Details (or click the document’s name) to see the content’s 
properties, type, and history.

View an Attachment – Retrieve a document’s attachment by clicking the item in the 
Attachment column. Click OK to view it or click Save to copy it to another location.

Editing Content – Use the Administration Console to modify and delete content in your 
repository.

Control the Number of Documents that Display – Click Get Item and Page Count to 
display the number of items retrieved and the page count.

Searching Content
To perform a search, click the Search tab in the CM Browser portlet. Enter the search string and 
click Search. The results appear in the portlet. You can also search using a Saved Search. See 
“Using the Search Portlets” on page 7-46 for more information on searching the content in the 
CM Portlet, the GroupSpace Community, and outside the GroupSpace Community.

../security/index.html
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Using the Search Portlets
The Search portlets let you perform full text searches and browse information. All American 
Standard Code for Information Interchange (ASCII) characters are supported in a search 
expression.

You can perform three types of search in the GroupSpace Community:

Portlet Search – Allows you to search the portlet you are using. For example, a Contacts 
Search for Smith retrieves contacts named Smith listed in your Addressbook.

GroupSpace Search – Lets you search the current GroupSpace Community for content 
(by searching Links, Issues, Announcements, Documents, and so on). You can search the 
Community where you are logged in. You cannot search other Communities if you are not 
logged into that Community.

GS Enterprise Search – Helps you locate information outside the GroupSpace 
Community. You can search information stored on your server’s file system or on a web 
site. An Enterprise Search does not retrieve GroupSpace Community data or data stored in 
other BEA content repositories. Use the Content Management Browser portlet to retrieve 
data stored in other BEA content repositories.

Configuring an Enterprise Search
You must configure the GS Enterprise Search portlet to narrow its scope. For example, if you 
want to search URLs, you must add the URLS where the search can be performed to a 
configuration file. If you do not restrict an Enterprise Search, the results could be too large for 
you to manage. 

Three configuration files exist for an Enterprise Search:

The AutonomyIDOLServer.cfg file – Performs a keyword search of databases that you 
specify in the configuration file. Do not modify the AutonomyIDOLServer.cfg file.

The HTTPFetch.cfg file – Performs a keyword search of the URLs that you added to the 
configuration file. The HTTPFetch.cfg file is located in the 
\<WEBLOGIC_HOME>\cm\thirdparty\autonomy-wlp10\win32\ HTTPFetch\ directory. 
Go to the [SPIDER] section and add the URLs to the web sites that you want users to be 
able to search. For example, the following entry in the HTTPFetch.cfg file makes the web 
sites www.johnsmith.com and www.yahoo.com targets for an Enterprise Search:

[SPIDER]
IMPORTPATH=../HTTPFetch
INDEXPATH=../HTTPFetch
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NUMBER=2
0=CANDER
1=YAHOO
[CANDERS]
URL=http://www.johnsmith.com
Directory=JSMITH
LogFile=JSMITH.log
[YAHOO]
URL=http://www.yahoo.com
Directory=YAHOO
LogFile=YAHOO.log

Tip: If you perform a search immediately after modifying the HTTPFetch.cfg file, the 
indexing is not completed and the search will not retrieve any results. Allow time for 
the indexing to finish.

The FileSystemFetch.cfg file – Performs a keyword search of the files on your hard drive 
or network drive. The FileSystemFetch.cfg file is located in the 
\<WEBLOGIC_HOME>\cm\thirdparty\autonomy-wlp10\win32\ FileSystemFetch\. 
Go to the [IMPORT] section and specify the path to the data directory that you want users 
to be able to search and specify the types of documents to search. The following example 
shows the document types you can search:
[Import]
DirectoryPathCSVs=./data
DirectoryFileMatch=*.txt,*.htm?,*.pdf,*.doc,*.xls,*.ppt,*.rtf,*.sgml,*.
xml,*.wml,*.qxd
DirectoryRecurse=on

Performing an Enterprise Search
Perform the following steps to perform an Enterprise search:

1. Log in as a GroupSpace Community owner, creator, or member.

2. Select the Search tab.

3. In the GS Enterprise Search portlet, enter the keywords for your query by completing the 
following fields:

– All of these words – Retrieves documents that contain every word listed in this field, 
in any order.

– This exact phrase – Retrieves documents that contain an exact match, in this precise 
order.
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– Any of these words – Retrieves documents that contain at least one of the words listed 
in this field.

– Include the following sources in the search – Select the drop-down list to pick 
individual content repositories or all databases that were configured to be searched. See 
“Configuring an Enterprise Search” on page 7-46.

See Figure 7-25 for an example.

4. Click Search. The results display at the bottom of the Search portlet.

Figure 7-25  An Enterprise Search of Three Databases for the Word Climbing

5. Click Download to save a local copy of a document.

Performing a GroupSpace Search
A GroupSpace Search retrieves content and properties that are contained in the GroupSpace 
Portlets (Links, Issues, Document Library, Discussion Forums, and so on). For example, 
searching your GroupSpace application for an author with a specific name can retrieve 
documents written by the person, topics the person posted in a Discussion Forum, and so on.

If you want to perform a GroupSpace Search for restricted values (values that appear in a 
drop-down list, such as Priority or Status), you should perform a Field Search, rather than a Full 
Text Search. Within your Field Search, select the value from the drop-down list, such as In 
Progress for a Status field when searching Issues. 
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Perform the following steps to perform a GroupSpace search:

1. Select the Search tab or click the global Search button.

2. If you have already created a Saved Search, select the drop-down list to pick a search that you 
created and stored. See “Saving Your Search Queries” on page 7-51 for instructions on saving 
a search phrase.

3. In the GS Search portlet, select Full Text Search or Field Search. A Full Text Search lets you 
search on specific words that might be part of either the property or the binary data. A Field 
Search searches just content properties, such as title, description, owner, status, resolution, 
and so on for the terms you specify for the portlets you want to search.

4. In the Resource Type drop-down list, select which GroupSpace portlet you want to search. 
You can search all the data in the portlets that are listed, or you can narrow your search to a 
specific portlet.

Tip: You cannot perform a Field Search for the Discussion Forums portlet; Discussions 
does not appear in the Resource Type drop-down list.

5. Depending on the option you specified in step 4, complete the fields for the search query.

6. Click Search. The results display at the bottom of the Search portlet, as shown in Figure 7-26.
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Figure 7-26  A GroupSpace Search of All Portlets for the Word Project

Performing a Portlet Search
You can search the following portlets:

GS Issues

GS GroupNotes

Discussion forums

Mail

Contacts

Tasks

GS Document Library

GS Links

CM Browser

GS RSS Reader

If you want to perform a Portlet Search for restricted values (values that appear in a drop-down 
list, such as Priority or Status), you should perform a Field Search, rather than a Full Text Search. 
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Within your Field Search, select the value from the drop-down list, such as In Progress for a 
Status field when searching Issues. 

Perform the following steps to perform a portlet search:

1. Select the tab for the portlet you want to search and select the Search tab or locate the Search 
bar in the portlet.

2. If you are using the portlet’s Search bar, enter the keyword, as shown in Figure 7-27.

Figure 7-27  Portlet Search for the Word Project

If you are using the query builder in the portlet’s Search tab, select Full Text Search or 
Field Search. A Full Text Search lets you search on specific words that might be part of 
either the property or the binary data. A Field Search searches just content properties, such 
as title, description, owner, status, resolution, and so on for the terms you specify for the 
portlets you want to search.

Enter the keywords for your query by completing the following fields:

– All of these words – Retrieves items with every word listed in this field.

– This exact phrase – Retrieves items that contain an exact keyword match.

– Any of these words – Retrieves items that contain at least one of the words listed in 
this field.

3. Click Search. The search results appear in the portlet. You can change the order in which they 
appear by clicking a column header.

Saving Your Search Queries
You can save your search terms so that you or other Community members can run them again 
later. A saved search consists of the search term, but not the search results. You can re-run the 
search exactly as it was saved or you can edit the search query before you run it. When you save 
the search term, you can determine who can view the saved search by marking it as Community, 
Personal, or Private.

You can save your search queries and run them against the following portlets:

GS Issues

GS Links
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GS GroupNotes

GS Document Library

GS RSS Reader

Discussion Forums

Creating a Saved Search
Perform the following steps to create and save a search query:

1. Select the Search tab.

2. Select Full Text Search or Field Search. A Full Text Search searches all properties for your 
search term, while a Field Search searches specific properties, such as Title, Description, or 
Visibility for the values you enter.

3. At Resource Type, use the drop-down list to select which portlet you want to search. You can 
also select All to search all five portlets.

4. Complete the remaining fields for your query and click Save Search.

5. Complete the Title and Description fields for the saved search. The Title field must be unique 
according to the visibility—you can have a Private Default Search in the GS Issues portlet 
called Project and a Community Default Search in the GS Issues portlet called Project, but 
you cannot have two Community Default Searches in GS Issues that are both called Project. 

6. At Visibility, select one of the following options to determine who can see the saved search: 

– Community – The saved search query is visible to the entire Community

– Personal – The saved search query is visible to all Communities to which you belong

– Private – The saved search query is visible just to you in this Community

7. Click Save to store and run the search.

8. Click Search to run the search.

Tip: You can also search an individual portlet by selecting the Search tab within a portlet. For 
example, you can search only the GS Issues portlet.
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Running a Saved Search
Perform the following steps to run a saved search:

1. Select the Search tab.

2. In the Saved Searches field, select a search query from the drop-down list. The fields are 
populated with the choices you made when you saved the search.

3. Click Search.

Editing the Properties of a Saved Search
Perform the following steps to change the name, description, and visibility (only from Private to 
Community) of a saved search:

1. View your saved searches by clicking Manage Saved Searches.

2. Click Edit Search to change the name or description of the search, or who can see the saved 
search. (If you want to change the search term, create a new search.) You can change the 
visibility of a saved search query only from Private to Community. You can also delete a 
saved search from the Manage Saved Searches page by selecting the check box next to the 
search and clicking Delete Searches.

3. From the Manage Saved Searches page, click Done.

Optimizing Portlet Performance
When you perform a GroupSpace search or a portlet search, the speed of the search can be 
affected by how you sort the columns and properties in the portlets. Some GroupSpace data has 
explicit properties, such as Title, Description, Owner, and Visibility. You can efficiently sort 
these explicit properties. All other properties are implicit. An implicit property sort is performed 
in memory after the data is retrieved. If your implicit property sort results in a large amount of 
data, you could experience a small delay in viewing the data.
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